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Introducción

Gracias por elegir a Medtronic Diabetes como aliado para que usted y sus pacientes tengan

un mejor control del tratamiento de la diabetes. Creemos que se beneficiará de la tecnología

de vanguardia del programa CareLink® Pro y de la sencilla  interfaz de usuario basada en

menús.

CareLink Pro permite adquirir los datos de diagnóstico y tratamiento del paciente así  como

guardarlos y crear informes sobre los mismos. También puede utilizarlo para acceder a los

datos de glucosa de la bomba, del medidor y del sensor que los pacientes han transferido a

CareLink® Personal,  un programa para la gestión del tratamiento basado en web que funciona

con CareLink Pro.

Características

CareLink Pro es un programa para la gestión del tratamiento de la diabetes para ordenadores

personales (PC).  Incluye las siguientes características:

• Pueden crearse registros de pacientes para almacenar datos obtenidos del dispositivo de un

paciente así como datos de la terapia de su cuenta de CareLink Personal.

• Los datos de las bombas de insulina, de los monitores y de los medidores de glucosa pueden

enviarse al progama, almacenarse y después utilizarse para generar informes.

• Opcionalmente, se comunica con el sistema CareLink Personal, permitiendo el acceso a los

datos del dispositivo que los pacientes han almacenado ahí. Esto es ideal para crear informes

actualizados entre las visitas al consultorio, y puede hacer innecesario leer los datos del

dispositivo durante las visitas.

• Pueden crearse diferentes informes de la terapia a partir de los datos del dispositivo

almacenados en el registro del paciente. Los informes ayudan a responder a preguntas del

tratamiento tales como el cumplimiento por parte del paciente, los patrones y las

excepciones.

• El progama le avisa si hay actualizaciones del software disponibles para descargar e instalar.

Esto le garantiza el acceso a las características más recientes.
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• La función Guide Me (Guíame) es una ayuda para los usuarios que utilizan CareLink Pro por

primera vez. Proporciona sugerencias y consejos sobre las tareas que están realizando.

• El programa dispone de un sistema de ayuda integrado que proporciona información sobre

áreas específicas de interés.

Pregunta

• CareLink Pro puede protegerse con contraseña.

• La transmisión de los datos de pacientes desde CareLink Personal se encripta mediante SSL

(Secure Sockets Layer, capa de protección segura), un estándar de la industria.

Documentos relacionados

Todos los documentos de Medtronic MiniMed indicados a continuación contienen

información específica del dispositivo que no se trata en detalle en esta guía del usuario.

NOTA: Para los medidores de otras compañías, véanse las instrucciones incluidas por el

fabricante con el medidor.

• Guía del usuario de la bomba de insulina Paradigm

• Guía del usuario del monitor Guardian REAL-Time

• Guía del usuario de las características del sensor

• Guía del usuario de ComLink

• Guía del usuario del dispositivo USB CareLink

Asistencia técnica

Si necesita más ayuda relativa a este programa, póngase en contacto con el representante

local.  Si desea obtener información sobre la lista de contactos internacionales, acuda a la

siguiente página:

http://www.medtronicdiabetes.com/help/contact/locations.html

Dispositivos compatibles

CareLink Pro obtiene datos de los dispositivos indicados a continuación.

NOTA: Es posible que algunos de los dispositivos compatibles con este programa de
software no estén disponibles en todos los países en los que el programa está aprobado

para su uso.
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Bombas de insulina/monitores de glucosa

Bombas de Medtronic MiniMed: 508

Bombas de insulina de la serie Paradigm® de Medtronic
MiniMed:

511, 512, 712, 515, 715, 522,  722, 522K, 722K,
Paradigm® Veo™ (554, 754)

Monitores Guardian REAL-Time:
CSS-7100

CSS-7100K

Fabricante Medidores de glucosa en sangre

Dispositivos asociados compatibles con Medtronic
Diabetes:

• Bayer CONTOUR® LINK

• Monitor de glucosa en sangre BD Paradigm
Link®

LifeScan:

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2

• OneTouch® UltraMini®

• OneTouch® UltraEasy®

Bayer:

• Ascensia BREEZE®

• BREEZE® 2

• CONTOUR®

BD: • Logic®

Familia Bayer Ascensia® DEX®, que incluye los siguientes
medidores compatibles:

• Ascensia® DEX®

• Ascensia® DEX® 2

• Ascensia® DEXTER-Z® II

• Glucometer® DEXTER-Z®

• Ascensia® ESPRIT® 2

• Glucometer® ESPRIT®

• Glucometer® ESPRIT® 2

Familia Bayer Ascensia ELITE™, que incluye los siguientes
medidores compatibles:

• Ascensia ® ELITE™

• Glucometer ELITE® XL
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Fabricante Medidores de glucosa en sangre

Abbott:

• FreeStyle®

• FreeStyle® Lite®

• FreeStyle® Freedom®

• FreeStyle® Freedom Lite®

• Precision Xtra™

• TheraSense FreeStyle®

• FreeStyle® Flash®

• FreeStyle® Papillon™ mini

• FreeStyle® Mini®

• Optium Xceed™

• Precision Xceed™

Roche:

• Accu-Chek® Aviva

• Accu-Chek® CompactPlus

• Accu-Chek® Compact

• Accu-Chek® Active

Dispositivos de comunicación

Com-Station
Para uso con la bomba Medtronic MiniMed 508.
(Véanse en la guía del usuario de Com-Station los
detalles sobre los requisitos de hardware).

ComLink

Para uso con la bomba MiniMed Paradigm y el
monitor Guardian REAL-Time. (Véanse en la guía
del usuario de ComLink los detalles sobre los
requisitos de hardware).

Medidor de glucosa en sangre Paradigm Link®

Para uso con la bomba MiniMed Paradigm y el
monitor Guardian REAL-Time. (Véanse en la guía
del usuario del medidor de glucosa en sangre
Paradigm Link® los detalles sobre los requisitos de
hardware.)

USB CareLink® Para uso con la bomba de insulina MiniMed
Paradigm y el monitor Guardian REAL-Time.

Cable de comunicación de datos

Para uso con medidores de glucosa de otros
fabricantes. Cada fabricante de medidores
suministra un cable de comunicación de datos.

Nota: Si un fabricante de medidores proporciona
un cable USB en lugar de un cable en serie para
cargar datos, debe instalar el controlador del
programa proporcionado por el fabricante.

Además, compruebe con el fabricante de
medidores si el controlador USB es compatible
con su sistema operativo. Es posible que algunos
controladores USB no estén disponibles para
sistemas operativos de 64 bits.

Dispositivos equivalentes

Al añadir un dispositivo al programa, hay que seleccionar la marca y el modelo en una lista.

Si no aparecen en la lista la marca y el modelo de un dispositivo, consulte la siguiente tabla

para encontrar uno equivalente.
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Si el  paciente utiliza uno de estos dispositivos Seleccione este dispositivo

• Bayer Ascensia® DEX® 2

• Bayer Ascensia® DEXTER-Z® II

• Bayer Glucometer® DEXTER-Z®

• Bayer Ascensia® ESPRIT® 2

• Bayer Glucometer® ESPRIT®

• Bayer Glucometer® ESPRIT® 2

Bayer Ascensia® DEX®

Bayer Glucometer ELITE® XL Bayer Ascensia ELITE™

Precision Xceed™ Optium Xceed™

Pedidos

Para realizar un pedido de productos de Medtronic Diabetes, contacte con su representante

local.  Si desea obtener información sobre la lista de contactos internacionales, acuda a la

siguiente página:

http://www.medtronicdiabetes.com/help/contact/locations.html

NOTA: Los medidores pueden solicitarse a las respectivas compañías.

Cómo utilizar esta guía

NOTA: Esta guía del usuario muestra ejemplos de las pantallas del programa. Las
pantallas del progama real pueden ser ligeramente diferentes.

Consulte el  glosario para ver las definiciones de términos y funciones. En la tabla siguiente se

definen las convenciones empleadas en esta guía.

Término/estilo Significado

Hacer clic Pulsar el botón izquierdo del ratón sobre un
objeto de la pantalla para seleccionarlo.

Hacer doble clic Pulsar dos veces el botón izquierdo del ratón
sobre un objeto de la pantalla para abrirlo.

Hacer clic con el botón derecho Pulsar el botón derecho del ratón sobre un objeto
de la pantalla para abrir otra ventana o menú.

Texto en negrita

Utilizado para un botón, nombre de pantalla,
nombre de campo u opción de menú. Por
ejemplo: Patient (Paciente)> New Patient (Nuevo
paciente)

NOTA: Proporciona información adicional para un
procedimiento o paso.
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Término/estilo Significado

PRECAUCIÓN:
Avisa de un peligro que, de no evitarse, podría
causar daños leves o moderados al programa o al
equipo.

ADVERTENCIA:

Le avisa de un peligro potencial que, de no
evitarse, podría causar lesiones graves o incluso la
muerte. Puede describir también posibles
reacciones adversas graves y peligros de
seguridad.

Seguridad del usuario

Indicaciones de uso

CareLink Pro está destinado a utilizarse como herramienta para facilitar la gestión de la

diabetes. La finalidad de este programa es recoger la información transmitida por bombas de

insulina, medidores de glucosa y sistemas de monitorización continua de glucosa y

transformarla en informes de CareLink Pro. Los informes proporcionan información que puede

utilizarse para identificar tendencias y hacer un seguimiento de las actividades cotidianas,

como la cantidad de carbohidratos ingeridos, las horas de las comidas, la administración de

insulina y las lecturas de glucosa.

Advertencias

• Este progama está destinado a ser utilizado por un equipo médico familiarizado con la

gestión de la diabetes.

• Los resultados del progama no están pensados para establecer un dictamen médico y no

deben utilizarse con dicho objetivo.

• Este producto sólo debe utilizarse con los dispositivos compatibles indicados en este

documento. (Consulte Dispositivos compatibles en la página 2).

• Debe aconsejarse a los pacientes que controlen sus niveles de glucosa en sangre al menos 4

– 6 veces al día.

• Debe indicarse a los pacientes que no realicen cambios en su tratamiento sin consultar antes

a su equipo médico.

• Debe indicarse a los pacientes que las decisiones terapéuticas que tomen deben basarse en

las instrucciones del equipo médico y en los resultados del medidor de glucosa en sangre y

no en los resultados del sensor de glucosa.

Contraindicaciones

Este programa no debe utilizarse con dispositivos no mencionados en el apartado Dispositivos

compatibles en la página 2.  Tampoco debe utilizarse este producto para el tratamiento de

enfermedades distintas de la diabetes.

Antes de abrir este programa, cierre los siguientes programas que estén ejecutándose en ese

momento en el ordenador:

• Programa de software CGMS® System Solutions™ (7310)

• Programa Solutions® Pumps & Meters (7311)
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• Programa Guardian® Solutions® software (7315)

• ParadigmPAL™ (7330)

• Programa CareLink® Personal (7333)

• Programa Solutions® para CGMS®iPro (7319)
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Cómo comenzar

La siguiente información le guiará para iniciar el programa CareLink Pro, abrir y cerrar

registros de pacientes y establecer las preferencias que desee aplicar a todos los pacientes del

programa.

Antes de empezar

Si esta es la primera vez que utiliza el programa CareLink Pro, debe asegurarse de configurar

las preferencias generales (consulte el apartado Preferencias generales en la página 13).  Estas

preferencias determinan cómo se muestran ciertos elementos en el programa y en los

informes, y cómo desea que el programa se comunique con internet.

Las preferencias pueden configurarse en cualquier momento. Si  lo desea, puede esperar a

estar familiarizado con el programa CareLink Pro para configurar las demás preferencias.

Tareas principales del programa

En la tabla siguiente se resumen las tareas principales que hay que realizar al configurar y

utilizar por primera vez CareLink Pro. También se indica en qué parte de esta guía del usuario

se comenta cada tarea.

Incremento de insulina Ubicación

Familiarícese con la interfaz del usuario del programa
CareLink Pro. Navegación por el  programa en la página 9

Definir  las opciones globales del programa que utilizará
el centro sanitario.

Configuración de las preferencias del  sistema en la
página 13

Crear perfiles para cada paciente. Cómo añadir nuevos perfiles en la página 22

Conectarse a las cuentas de CareLink Personal de sus
pacientes.

Conexión al  programa CareLink Personal en la
página 23

Añadir la bomba y los medidores de los pacientes'  a sus
perfiles. Cómo añadir un dispositivo en la página 30

Leer los datos de la bomba y de los medidores de los
pacientes.

Cómo leer  los datos de un dispositivo en la
página 36
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Incremento de insulina Ubicación

Configurar y generar informes para cada paciente. Crear informes en la página 40

Hacer periódicamente una copia de seguridad de la
base de datos el programa CareLink Pro.

Hacer una copia de seguridad de la base de datos en
la página 52

Actualizar el programa CareLink Pro. Actualizaciones del software en la página 50

Navegación por el programa

Antes de trabajar con el programa CareLink Pro, debe familiarizarse con la interfaz de usuario.

La interfaz del usuario incluye menús, una barra de herramientas, una barra de navegación,

áreas de trabajo y la ventana Guide Me (Guíame).

Abrir el programa CareLink Pro

1 Haga doble clic en el icono de CareLink Pro  en el escritorio de su equipo, o seleccione

Medtronic CareLink Pro  en la lista de programas del menú Inicio de Windows.

Si su hospital requiere que introduzca una contraseña, se muestra la pantalla de inicio de

sesión.

a. Escriba la contraseña en el campo Password (Contraseña).

NOTA: La necesidad de introducir una contraseña es una función opcional que se
configura durante el  proceso de instalación.

b. Haga clic en LOGIN (Inicio de sesión).

Aparece la pantalla de inicio.

2 Para iniciar un nuevo registro de cliente, haga clic en New Patient  (Nuevo paciente).  Para

abrir un registro de cliente de una lista de pacientes del sistema, haga clic en Open Patient

(Abrir paciente).

Áreas de trabajo

Si tiene abierto un registro de paciente, puede hacer clic en uno de los botones de la barra de

navegación para mostrar el área de trabajo correspondiente. Utilice estas áreas de trabajo

para introducir o seleccionar información para realizar tareas de CareLink Pro para ese

paciente.
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Perfil:   le permite mantener almacenada
información del paciente tal como el nombre
y la fecha de nacimiento. Esta área de trabajo
le permite también vincularse con la cuenta
personal de CareLink de un paciente.

Dispositivos:  le permite almacenar
información necesaria para leer los
dispositivos de un paciente.

Informes:  le permite seleccionar parámetros
y elegir los informes que desee generar para
el paciente.

Hasta que añade y guarda un perfil  para un cliente, sólo el area de trabajo del perfil está

accesible para ese paciente. Hasta que se agregan los dispositivos para un paciente, sólo las

áreas de trabajo Perfil  y Dispositivos están accesibles para ese paciente.

Barra de herramientas

La barra de herramientas de CareLink Pro proporciona acceso rápido a funciones utilizadas

frecuentemente. La barra de herramientas contiene los botones siguientes.

Botón Nombre Función

Botón Add Patient (Añadir
paciente)

Abre un área de trabajo Perfil,
de tal modo que puede agregar
un nuevo registro del paciente
al sistema.

Open Patient (Abrir paciente)

Abre la tabla Patient Lookup
(Búsqueda de pacientes), en la
que puede elegir un registro de
paciente existente para ver.

Guide Me (Guíame)

Muestra u oculta la ventana
Guide Me (Guíame). Haga clic
para ver sugerencias
contextuales del programa.

Fichas de paciente

Cuando se abre un registro de paciente, se muestra una ficha en la barra de herramientas con

el nombre del paciente. Si una ficha está activa, eso significa que el registro del paciente y el

área de trabajo están activos y que puede realizar tareas de CareLink Pro para ese paciente.

Para activar el registro de un paciente de forma que pueda trabajar con él,  haga clic en la ficha

de dicho paciente. Para cerrar el  registro de un paciente, haga clic en el botón Close (Cerrar)

 de la ficha.
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La función Guide Me (Guíame)

La función Guide Me (Guíame) se proporciona a través de CareLink Pro. Abre una ventana con

sugerencias y consejos contextuales para acciones que podría realizar en la parte del

programa que está activa. Las ventanas de la función Guide Me (Guíame) también pueden

incluir vínculos >>learn more  (más información). Al hacer clic en estos vínculos, se accede a la

sección relevante de la ayuda en línea que muestra información más detallada. La función

Guide Me (Guíame) está activada de manera predeterminada. Sin embargo, puede

desactivarla en cualquier momento.

Activación y desactivación de la función Guide Me (Guíame)

Para activar o desactivar esta función, realice una de las siguientes acciones:

• Haga clic en el botón Guide Me (Guíame). 

• Seleccione Help (Ayuda)  > Guide Me (Guíame).

Apertura de registros de pacientes

Pueden abrirse un máximo de seis registros de pacientes al  mismo tiempo. Si no ha creado

todavía ningún perfil  de paciente, consulte el apartado Cómo añadir nuevos perfiles  en la

página 22.
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1 Seleccione File > Open Patient (Archivo > Abrir paciente) o haga clic en el botón Open

Patient  (Abrir paciente).  Aparece una lista de pacientes similar a la que aparece aquí a

continuación.

NOTA: Si recibe un mensaje que indica que tiene demasiados registros de pacientes

abiertos, haga clic en OK (Aceptar),  cierre un registro y continúe.

2 Localice el nombre del paciente en la lista escribiendo parte de su nombre o su nombre

completo en el campo Find a Patient (Buscar paciente). Si el listado de pacientes aparece,

haga clic en OPEN (Abrir), doble clic en el listado o pulse INTRO. También puede desplazarse

por la lista utilizando las flechas arriba y abajo del teclado.

Se muestra el área de trabajo Devices  (Dispositivos) (si no se han añadido todavía

dispositivos) o Reports  (Informes) del paciente.

3 Para consultar el área de trabajo Perfil  del paciente, haga clic en el botón Profile (Perfil)

 en la barra de navegación.

Cierre de registros de pacientes

1 Asegúrese de que esté activo el registro de paciente que desee cerrar (la ficha aparece

resaltada).

2 Realice una de las acciones siguientes:

a. Seleccione File > Close Patient  (Archivo > Cerrar paciente).

b. Haga clic en el botón Close (Cerrar)  de la ficha del paciente.

c. Pulse Ctrl+F4.
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Configuración de las preferencias del sistema

Estas preferencias se aplican a todos los pacientes del programa. Las preferencias aplicables

únicamente a pacientes individuales se describen en el apartado Comprobar la configuración

de los informes en la página 43.

Las preferencias se presentan en los siguientes grupos:

• General (Generales)

- Unidades de glucosa

- Unidades de carbohidratos

- Comunicaciones

- Resolución de problemas

• Patient Profile (Perfil del paciente)

- Permite seleccionar y organizar los campos de datos en los perfiles de pacientes.

• Patient Lookup (Búsqueda de pacientes)

- Permite modificar y cambiar el orden de los campos mostrados cuando se elige Open

Patient (Abrir paciente) para ver una lista de pacientes.

• Report Generation (Generación de informes)

- Permite seleccionar los campos de datos que se desee mostrar al seleccionar los datos

de los informes Daily Detail (Detalles diarios) en la tabla de datos.

Preferencias generales

Utilice la ficha General para definir cómo muestra el software determinados tipos de

información y establecer las preferencias de comunicación externas.

1 Si no está ya activa, haga clic en la ficha General.

2 Seleccione Tools > Options  (Herramientas > Opciones). Aparece la ventana mostrada a

continuación.
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3 Haga clic para seleccionar el botón de opción del valor que desee:

- Unidades de glucosa:  mg/dL o mmol/L.

- Carbohydrate Units  (Unidades de carbohidratos): grams (gramos) o Exchanges

(Raciones).

a. Si ha seleccionado Exchanges  (Raciones) para Carbohydrate Units  (Unidades de

carbohidratos), escriba el número adecuado en el campo gramos igual a 1 ración.

4 Haga clic para seleccionar o desactivar la casilla de verificación en la sección Chart Options >

Overview Report. Si se activa la casilla de verificación, la aplicación conectará las lecturas de

glucosa de la tabla de Meter Glucose Overlay (Revestimiento del medidor de glucosa) con las

líneas. (Esta es una tabla que aparece en el informe Sensor and Meter Overview Report

[Informe de resumen del medidor y del sensor]).

5 Para las siguientes preferencias del cuadro Communications (Comunicaciones), haga clic para

seleccionar la casilla de verificación (activar) o para dejar vacía la casilla (desactivar):

NOTA: Asegúrese de seguir las instrucciones de su centro o del departamento
informático cuando configure las preferencias de comunicaciones.

- Automatically check for software updates (Comprobar automáticamente la

disponibilidad de actualizaciones del software):  si se selecciona esta opción, se

enviará un aviso a cada sistema que esté ejecutando el programa CareLink Pro siempre

que haya disponible una actualización del programa. El usuario activo tendrá la

oportunidad de descargar e instalar las actualizaciones. Para evitar que suceda esto e

instaurar una distribución controlada de las actualizaciones del software, desactive esta

casilla de verificación.

- Synchronize with Medtronic CareLink® Personal (Sincronizar con CareLink

Personal): si desea que el programa sincronice automáticamente los datos de CareLink

Personal de sus pacientes cada vez que abra su perfil, seleccione la casilla de verificación.

Si deja vacía esta casilla de verificación, tendrá que sincronizar manualmente los datos

del programa CareLink Personal para cada paciente.

6 Haga clic para seleccionar la casilla de verificación o para dejarla vacía en la sección

Troubleshooting  (Resolución de problemas). Si la casilla de verificación está seleccionada, la

aplicación guarda un registro de lecturas del dipositivo para resolución de problemas.

7 Haga clic en OK (Aceptar) para guardar las preferencias generales.

Preferencias de los perfiles de pacientes

Esta es una configuración global que define el contenido de los perfiles. Puede personalizar

los campos del área de trabajo Perfil  para incluir la información más importante para su

centro. Puede agregar o quitar campos, crear sus propios campos personalizados y determinar

el orden en el que aparecerán los campos en la ventana.

1 Seleccione Tools > Options  (Herramientas > Opciones).
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2 Haga clic en la ficha Patient Profile  (Perfil del paciente). Aparece la ventana mostrada a

continuación.

NOTA: Utilice las casillas de verificación para elegir los campos que desee incluir en

el  perfil.  Utilice las flechas arriba y abajo para ordenar los campos.

Cómo elegir campos de datos

1 Utilice las casillas de verificación para añadir los campos que desee.

NOTA: Los campos First Name (Nombre) y Last Name (Apellidos) no pueden

eliminarse.

2 Para eliminar un campo del perfil, deje vacía su casilla de verificación.

3 Para hacer que un campo sea obligatorio, seleccione la casilla de verificación

correspondiente en la columna Required  (Obligatorio). Los campos obligatorios deben

rellenarse para poder crear un perfil.

Cómo añadir un campo personalizado

1 Seleccione la casilla de verificación situada a la izquierda de un campo personalizado vacío.

2 Introduzca el nombre del campo (por ejemplo, Contacto para urgencias). Este es el nombre

del campo que aparecerá en el perfil del paciente.

3 Para hacer que el campo sea obligatorio, seleccione la casilla de verificación correspondiente

en la columna Required (Obligatorio).
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NOTA: Para eliminar un campo personalizado del perfil, deje vacía la casilla de

verificación situada junto al campo en cuestión.

Cómo cambiar el orden de los campos de datos

Seleccione el campo que desee mover y haga clic en las flechas arriba o abajo  para

moverlo. (Las flechas situadas en la parte superior e inferior mueven un campo hasta el

comienzo o el final de la lista).

Finalización de las preferencias de los perfiles de pacientes

Cuando la lista Field Order (Orden de campos) tenga todos los campos que desea en el orden

correcto, haga clic en OK  (Aceptar).

Los perfiles de pacientes ya tienen los campos que acaba de seleccionar, en el orden

seleccionado.

Preferencias de búsqueda de pacientes

La tabla Patient Lookup (Búsqueda de pacientes) se utiliza para buscar y abrir un registro de

paciente. La tabla incluye a cada paciente de su base de datos y proporciona información de

identificación del perfil del paciente. Tiene la opción de personalizar la información que se

muestra en esta tabla y el orden en que aparecen las columnas. Para personalizar la tabla

Patient Lookup (Búsqueda de pacientes), realice los siguientes pasos:

1 Seleccione Tools > Options  (Herramientas > Opciones).

2 Haga clic en la ficha Patient Lookup  (Búsqueda de pacientes). Aparece la ventana mostrada

a continuación.
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NOTA: Utilice las casillas de verificación para elegir los datos que desee en la tabla

Patient Lookup (Búsqueda de pacientes).  Utilice las flechas arriba y abajo para
ordenar las columnas.

Cómo elegir los datos que se desea mostrar

Utilice las casillas de verificación para seleccionar el tipo de datos que desea mostrar o para

eliminar los datos que no desea mostrar en la tabla Patient Lookup (Búsqueda de pacientes).

Cómo cambiar el orden de las columnas

Para cambiar el  orden de las columnas en la tabla Patient Lookup (Búsqueda de pacientes),

seleccione la columna que desee mover y haga clic en las flechas arriba o abajo.  (Las

flechas situadas en la parte superior e inferior mueven una columna de datos hasta el

comienzo o el final de la lista).

La columna de datos situada en la parte superior de la lista Column Display Order (Orden de

presentación de las columnas) aparecerá en la primera columna de la tabla Patient Lookup

(Búsqueda de pacientes).  La columna de datos situada en la parte inferior aparecerá en la

última columna de la tabla.

Finalización de las preferencias de búsqueda de pacientes

Cuando la lista Column Display Order (Orden de presentación de las columnas) tenga todos

los datos que desea en el orden correcto, haga clic en OK  (Aceptar).

La tabla Patient Lookup (Búsqueda de pacientes) tendrá ahora los datos y el  orden de

columnas que acaba de seleccionar.

Preferencias para la generación de informes

La tabla de datos aparece en la ventana Select and Generate Reports (Seleccionar y generar

informes).  Esta tabla se utiliza durante el informe. Contiene información diaria derivada de

los dispositivos del paciente y, si  procede, su cuenta del programa CareLink Personal.  Los

datos proporcionados en esta tabla le ayudan a determinar los días en los que se necesita

un informe de detalles diarios. También ayuda a decidir cuál de los otros informes debería

ejecutar.

Su centro puede personalizar los datos mostrados en esta tabla, incluyendo el orden en que

se presentan, para reflejar aquellos que son más importantes para su consultorio.

NOTA: Para ver cómo se aplican estas preferencias a la tabla de datos durante la creación

de informes, consulte el apartado Seleccionar los tipos de informes y las fechas de inclusión

en la página 45.

1 Seleccione Tools > Options  (Herramientas > Opciones).
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2 Haga clic en la ficha Report Generation (Generación de informes). Aparece la ventana

mostrada a continuación.

Cómo elegir los datos que se desea mostrar

Utilice las casillas de verificación para seleccionar el tipo de datos que desea mostrar o para

eliminar los datos que no desea mostrar en la tabla de datos.

La siguiente información está disponible para inclusión en la tabla de datos.

Nombre de columna Definición

№ of Meter Readings (Nº de lecturas del medidor) La cantidad de lecturas de la fecha especificada que
los dispositivos incluidos han grabado.

Meter Readings Average (Promedio de lecturas del
medidor)

El promedio de las lecturas de glucosa grabado por
los dispositivos incluidos.

Sensor Duration (Duración del sensor)
La cantidad de tiempo dentro de la fecha
especificada para la que se grabó la fecha del
sensor. Los valores -- (ninguno), 0:05 -  24:00.

Sensor Average (Promedio del sensor) El promedio de lecturas del sensor grabado en la
fecha especificada.

Highest Reading (Lectura más alta) La lectura de glucosa más alta (derivada de un
sensor o medidor) para la fecha.

Lowest Reading (Lectura más baja) La lectura de glucosa más baja (derivada de un
sensor o medidor) para la fecha.

Avg AUC Below Target (AUC prom. por debajo de
objetivo)

Área bajo la curva prom. por debajo del intervalo
del objetivo del paciente.

Avg AUC Above Target (AUC prom. por encima de
objetivo)

Área bajo la curva prom. por encima del intervalo
del objetivo del paciente.
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Nombre de columna Definición

Total Carbs (Total de carbohidratos)

La suma de todas las cantidades de carbohidratos
(redondeado al próximo gramo o al intercambio 0,1
más próximo, dependiendo de la unidad de
medición utilizada) activada durante el día mediante
Bolus Wizard events (Eventos de Bolus Wizard) o
marcadores de carbohidratos de la bomba o el
monitor Guardian.

Suspend duration (Duración de la interrupción)
La cantidad de tiempo que la bomba estuvo
suspendida en la fecha especificada. Los valores son
-- (ningún dato), 0:01 - 24:00.

№ of Rewinds (Nº de rebobinados) El número de rebobinados para la fecha
especificada.

№ of Primes (or Fills) (Nº de Cebados [o llenados]) El número de eventos de cebado (o eventos de
llenado) grabados para la fecha especificada.

Prime (or Fill) Volume (U) (Volumen (U) de cebado [o
llenado])

El volumen total de insulina utilizado para eventos
de cebado (o llenado) en la fecha especificada.

Total Insulin (U) (Insulina total [U]) El volumen total  de insulina suministrado durante la
fecha especificada, tal como la bomba ha grabado.

Total Basal  (U) (Basal total [U])

El volumen total de insulina basal suministrado
durante la fecha especificada (la insulina total
suministrada, menos la suma de todos los bolus
suministrados).

Total Bolus (U) (Bolus totales [U])
El volumen total de insulina suministrado en bolus
durante la fecha especificada, tal como la bomba ha
grabado.

Basal  % (% basal) Muestra la proporción (en % valores total) de
insulina basal a insulina total.

Bolus % (% bolus) Muestra la proporción (en % valores total) de
insulina bolus a insulina total.

№ of Boluses (Nº de bolus) El número de eventos bolus grabados para la fecha
especificada.

Bolus Wizard Events (Eventos de Bolus Wizard) El número total de eventos bolus wizard grabados
para la fecha especificada.

Bolus Wizard Overrides (Anulación de Bolus Wizard)
El número de eventos bolus wizard donde la
cantidad de insulina suministrada es diferente de la
cantidad recomendada.

№ of Meal Boluses (Nº de bolus de comida)
El número de eventos bolus wizard con cantidades
de carbohidratos superiores a cero que se grabaron
en la fecha especificada.

№ of Correction Boluses (Nº de bolus corrector)
El número de eventos bolus wizard con cantidades
de corrector superiores a cero que se grabaron en la
fecha especificada.

№ of Manual Boluses (Nº de bolus manual) El número de eventos bolus grabados durante la
fecha, que no eran eventos bolus wizard.

Cómo cambiar el orden de las columnas

Para cambiar el orden de las columnas de la tabla de datos, seleccione la columna que desee

mover y haga clic en las flechas arriba o abajo. (Las flechas situadas en la parte superior e

inferior mueven una columna de datos hasta el comienzo o el final de la lista).

CareLink Pro Guía del usuario   Cómo comenzar 19



NOTA: Los elementos situados en la parte superior de la lista Column Order (Orden de

columnas) aparecerán en la primera columna de la tabla de datos. Los elementos
situados en la parte inferior aparecerán en la última columna de la tabla de datos.

Finalización de las preferencias para la generación de informes

Cuando la lista Column Order (Orden de columnas) tenga todos los datos que desea en el

orden correcto, haga clic en OK  (Aceptar).

La tabla de datos tendrá ahora los datos y el orden de columnas que acaba de seleccionar.
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3

Área de trabajo Profile (Perfil)

Un perfil es similar a la portada de una historia clínica. Contiene información del paciente tal

como el nombre y la fecha de nacimiento. Se requiere un perfil para poder recopilar datos de

los dispositivos y utilizarlos para generar informes del tratamiento.

El área de trabajo Profile (Perfil)  también le permite establecer una conexión a la cuenta del

programa CareLink Personal.  Una vez establecida la conexión, puede recuperar los datos del

paciente almacenados en el programa CareLink Personal en cualquier momento, sin la

necesidad de que el paciente esté presente.

Antes de empezar

Si lo desea, puede personalizar los perfiles de pacientes para que sólo contengan el tipo de

información que desea obtener. Si desea más información, consulte el apartado Preferencias

de los perfiles de pacientes en la página 14.
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Además, se requieren un nombre de usuario y una contraseña al configurar la conexión a la

cuenta del programa CareLink Personal de un paciente. El paciente debe estar presente para

proporcionar estos datos.

Cómo añadir nuevos perfiles

Cada vez que añada un paciente al programa CareLink Pro, deberá comenzar creando un

perfil para el  paciente.

1 Seleccione File > New Patient  (Archivo > Nuevo paciente) o haga clic en el botón Add

Patient  (Añadir paciente). 

Aparece el área de trabajo Profile  (Perfil).

NOTA: Para añadir o modificar campos en el perfil  del paciente, haga clic en
customize fields (personalizar campos).  Consulte el apartado Preferencias de los perfiles

de pacientes en la página 14.

2 Rellene los campos de la sección Patient Profile  (Perfil del paciente).

3 Haga clic en SAVE  (Guardar).

Se añade el nuevo perfil de paciente a la base de datos del programa CareLink Pro. Aparecerá

un mensaje que confirma que se ha guardado el perfil.

Rellenar los campos obligatorios

1 Si se intenta guardar un perfil de paciente y no se ha rellenado un campo obligatorio,

aparecerá un mensaje junto a ese campo. No podrá guardar el perfil hasta que rellene el

campo.

2 Rellene el campo.

3 Haga clic en SAVE  (Guardar).

4 Cuando aparezca el mensaje de confirmación, haga clic en OK (Aceptar).

Edición de perfiles de pacientes

1 Asegúrese de que el área de trabajo Profile (Perfil) del paciente esté abierta.

2 Haga clic en EDIT  (Modificar).

3 Modifique los datos de la sección Patient Profile  (Perfil del paciente) según proceda.

4 Haga clic en SAVE  (Guardar).

Aparecerá un mensaje que confirma que se ha guardado el perfil.
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Cómo eliminar datos de pacientes del programa

1 Asegúrese de que el área de trabajo Profile (Perfil) del paciente esté abierta.

2 Compruebe que se trata del paciente que desea borrar. Cuando se borra un perfil de

paciente también se borran sus datos de la base de datos del programa CareLink Pro; esta

acción no puede deshacerse.

3 Haga clic en >> delete patient record  (borrar registro de paciente) encima de la sección de

sincronización del perfil.

Aparecerá un mensaje que le advierte de que al borrar el registro se borrarán todos los datos

del paciente.

4 Haga clic en Yes  (Sí) para borrar el registro del paciente.

Conexión al programa CareLink Personal

Si el paciente lo permite, puede configurar una conexión con la cuenta de CareLink Personal.

Esta herramienta de Internet permite a los pacientes transferir y guardar los datos de sus

dispositivos y ejecutar diversos informes del tratamiento.

Una vez conectado a la cuenta de CareLink Personal del paciente, puede recuperar los datos

de sus dispositivos que el paciente haya guardado en ella.  Esto es ideal para crear informes de

tratamiento de CareLink Pro entre las visitas a la consulta. También reduce la necesidad de

leer el  dispositivo del paciente a la consulta.

Si un paciente no tiene todavía una cuenta, el  programa CareLink Personal puede enviarle un

mensaje de correo electrónico invitándole a crear una.

Cómo conectar a una cuenta existente

NOTA: El paciente debe estar presente para realizar estos pasos.

1 Asegúrese de que está conectado a Internet.

2 Abra el área de trabajo Profile  (Perfil) del paciente.

3 Asegúrese de que estén rellenados todos los campos obligatorios de la sección Patient

Profile  (Perfil del paciente).

4 Haga clic en LINK TO EXISTING ACCOUNT  (Conectarse a una cuenta existente).

Aparece la pantalla Log In (Inicio de sesión) del programa CareLink Personal.

5 Pida al paciente que haga lo siguiente:

a. Rellene los campos Username (Nombre de usuario) y Password (Contraseña).

b. Haga clic en Sign In  (Entrar).

Se muestra la página Grant Access  (Concesión de acceso), basada en los ajustes del idioma y

el domicilio del paciente.

6 Pida al paciente que haga lo siguiente:
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a. Lea la sección Condiciones de uso.

b. Haga clic para marcar la casilla de verificación situada junto a la opción I agree to the

Terms of Use above… (Acepto las condiciones de uso anteriormente expuestas).

c. Haga clic en Grant Access (Conceder acceso).

d. Le avise cuando aparezca la página Thank You (Gracias).

7 Puede imprimir las condiciones de uso para el paciente haciendo clic en el botón Print

(Imprimir). Ya está conectado a la cuenta del programa CareLink Personal del paciente.

Cómo enviar una invitación por correo electrónico

Para enviar una invitación por correo electrónico a un paciente para crear una cuenta del

programa CareLink Personal, siga los pasos descritos a continuación:

1 Abra el área de trabajo Profile  (Perfil) del paciente.

2 Asegúrese de que estén rellenados todos los campos obligatorios de la sección Patient

Profile  (Perfil del paciente).

3 Haga clic en SEND E-MAIL INVITATION TO PATIENT (Enviar invitación por correo

electrónico al paciente).

4 Asegúrese de que estén rellenados correctamente los campos Patient Name  (Nombre del

paciente), Email Address (Dirección de correo electrónico) y Language (Idioma).

5 Haga clic en SEND  (Enviar).

El área de estado del perfil del paciente confirma que se ha enviado el mensaje de correo

electrónico.

Cómo obtener datos de una cuenta con conexión

Si está conectado a la cuenta del programa CareLink Personal de un paciente, los datos

nuevos que pueda haber en esta cuenta se enviarán automáticamente cada vez que abra su

perfil del paciente en CareLink Pro.
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NOTA: Para asegurarse de que este proceso tenga lugar, vaya a Tools > Options >

General (Herramientas > Opciones > Generales) y asegúrese de que haya una marca de
verificación junto a la opción “Synchronize with CareLink Personal” (Sincronizar con

CareLink Personal).

Siga los pasos indicados a continuación para obtener los datos del programa CareLink Personal

de un paciente en cualquier momento después de haber abierto su perfil de paciente:

1 Asegúrese de que el área de trabajo Profile (Perfil) del paciente esté abierta y de que esté

conectada a Internet.

2 Seleccione Tools > Synchronize Patient Data (Herramientas > Sincronizar datos del

paciente).

El icono  de sincronización de la ficha del paciente gira. Cuando el icono se detenga,

significa que el proceso ha finalizado.

NOTA: Si el paciente ya no quiere compartir sus datos de CareLink Personal,

aparecerá un mensaje anunciándoselo.

3 Los datos adicionales obtenidos del programa CareLink Personal aparecerán en los informes

del paciente.

Cómo desvincular la cuenta del programa CareLink Personal de un paciente del
programa CareLink Pro

Puede desvincular la cuenta del programa CareLink Personal de un paciente del programa

CareLink Pro. Esta opción sólo se encuentra disponible si el paciente ya ha estado conectado

previamente. Impide que el programa CareLink Pro continue recuperando datos de la cuenta

del programa CareLink Personal del paciente. No afecta a la cuenta personal existente del

paciente del programa CareLink Personal.

1 Abra el registro del paciente y vaya al área de trabajo Profile (Perfil).

2 Haga clic en UNLINK ACCOUNT (Desvincular cuenta).

3 Haga clic en YES (Sí) en el mensaje de confirmación. El perfil personal del paciente ya no está

conectado (Vinculado) al programa CareLink Pro.

El estado cambia a No vinculado  y ahora se muestran los botones LINK TO EXISTING

ACCOUNT  (Conectarse a una cuenta existente) y SEND E-MAIL INVITATION TO PATIENT

(Enviar invitación por correo electrónico al paciente).

CareLink Pro Guía del usuario   Área de trabajo Profile (Perfil) 25



4

Configuración del hardware

Para leer los datos directamente desde un dispositivo, debe disponer del dispositivo del

paciente y de los cables o dispositivos de comunicación necesarios para transferir los datos a

su ordenador.

Alternativamente, si el paciente ha cargado los datos del dispositivo en la cuenta de CareLink

Personal,  puede obtener los datos conectando con su cuenta. Para conectar con una cuenta

CareLink Personal de un paciente, consulte Conexión al programa CareLink Personal en la

página 23.

Conexión de dispositivos

Observe el esquema general para hacerse una idea de cómo deben conectarse los dispositivos

para que se comuniquen con el ordenador. Los esquemas presentados a continuación ilustran

aspectos específicos de la comunicación de los dispositivos.

Si desea más detalles, siga las instrucciones mostradas por el programa CareLink Pro durante

la lectura de los dispositivos.
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Descripción general de la configuración del hardware

Este ejemplo muestra el uso del USB CareLink para la comunicación entre la bomba y el

ordenador.

Ejemplos de conexión por cable en serie y USB:
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ComLink opcional para uso con bombas Paradigm:

Com-Station opcional para uso con la bomba Medtronic MiniMed 508
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5

Área de trabajo Devices (Dispositivos)

La información que tendrá que leer del dispositivo de un paciente, como por ejemplo la

marca, modelo, número de serie, se guarda en el área de trabajo Devices (Dispositivos). Por

tanto, no tiene que proporcionarla cada vez que lea los datos del dispositivo.

Los dispositivos del área de trabajo Devices (Dispositivos) se almacenan en una de estas dos

listas: Active Devices (Dispositivos activos) o Inactive Devices (Dispositivos inactivos).  Cuando

se añade un dispositivo, se agrega automáticamente a la lista Active Devices (Dispositivos

activos).  Sólo puede leer los datos de los dispositivos que aparezcan en la lista Active Devices

(Dispositivos activos).  Estos probablemente serán los dispositivos que utiliza actualmente el

paciente.

Los demás dispositivos pertenecientes al paciente que no se estén utilizando actualmente

pueden guardarse en la lista Inactive Devices (Dispositivos inactivos).  La información se

guardará en archivo. Estos dispositivos pueden activarse en cualquier momento.
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Antes de empezar

Para poder abrir el área de trabajo Devices (Dispositivos) para un paciente debe tener un perfil

guardado en el programa. Consulte el apartado Cómo añadir nuevos perfiles en la página 22.

Para añadir un dispositivo o leer los datos directamente de él,  debe estar en comunicación

con el ordenador. Consulte en Conexión de dispositivos en la página 26,  cómo configurar los

dispositivos para que establezcan comunicación con el ordenador.

Cómo añadir un dispositivo

Puede obtener datos de la cuenta de CareLink Personal del paciente para un dispositivo aún

no agregado. Dichos dispositivos se agregarán automáticamente cuando los datos se

sincronicen entre CareLink Personal y CareLink Pro.

NOTA: Sólo puede haber una bomba activa por paciente. Si se añade una nueva bomba,
se pasará la bomba existente a la lista de dispositivos inactivos.

Cómo añadir una bomba de Medtronic o un monitor Guardian

1 Asegúrese de que el dispositivo que está añadiendo esté configurado para comunicarse con

el ordenador. (Consulte Conexión de dispositivos en la página 26, para ver los pasos para la

conexión).

2 Haga clic en la ficha del paciente o haga doble clic sobre su nombre en la tabla Patient

Lookup (Búsqueda de pacientes).

3 Haga clic en Devices  (Dispositivos) para acceder al área de trabajo Devices

(Dispositivos) del paciente.

4 Haga clic en ADD DEVICE  (Añadir dispositivo).

5 Seleccione Medtronic Pump/Guardian  (Bomba de Medtronic/Guardian). Aparece el

asistente Add Medtronic Pump/Guardian  (Añadir bomba de Medtronic/Guardian).
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NOTA: El modelo de la bomba aparece indicado en la parte posterior de la bomba o

en la pantalla de estado de la bomba.

6 Seleccione el botón de opción para especificar el dispositivo que desea añadir.

Si ha seleccionado la opción MiniMed 508 pump (Bomba MiniMed 508), vaya al paso 9.

7 Haga clic en NEXT (Siguiente). Aparece la página Serial Number (Número de serie).

NOTA: Se mostrará un mensaje de error si no introduce el número de serie correcto.

Vea los ejemplos mostrados en esta página y compruebe que está introduciendo los
caracteres correctos indicados en la parte posterior de la bomba. Si fuera necesario,

vuelva a escribir los seis caracteres.

8 Utilice los ejemplos mostrados en esta página para localizar el número de serie de seis

caracteres del dispositivo que desea añadir. (Si necesita más ayuda para localizarlo, haga clic

en >> learn more  [más información]). Escriba los seis caracteres en el campo Device Serial

Number  (Número de serie del dispositivo).

9 Haga clic en NEXT (Siguiente). Aparece una página Communication Options (Opciones de

comunicación) similar a la mostrada a continuación.
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10 Haga clic en el menú desplegable Choose Port  (Elegir puerto) y seleccione el puerto del

ordenador al que se conecta el dispositivo ComLink, Paradigm Link®, USB CareLink o Com-

Station. Si no está seguro de qué puerto elegir, seleccione Auto Detect (or USB)  (Detectar

automáticamente [o USB]).

11 Haga clic en NEXT Siguiente. Aparece la página Test Connection  (Comprobar conexión),

similar a la mostrada a continuación.

12 Siga las instrucciones del dispositivo y haga clic en TEST (Comprobar).

Aparece un mensaje que le informa si la conexión ha sido satisfactoria. Si ha sido así, vaya al

siguiente paso.

NOTA: Esta comprobación no lee datos de la bomba, simplemente verifica que las
comunicaciones sean correctas entre la bomba y el ordenador.

Si no lo ha sido, asegúrese de que el hardware entre el dispositivo y el ordenador esté

correctamente conectado. Además, haga clic en BACK  (Atrás) en las páginas del asistente

para asegurarse de que los datos del dispositivo introducidos son correctos.

13 Haga clic en DONE  (Finalizar).

Se añade el dispositivo a la lista Active Devices (Dispositivos activos) del paciente.

Cómo añadir un medidor

1 Haga clic en la ficha del paciente o haga doble clic sobre su nombre en la tabla Patient

Lookup (Búsqueda de pacientes).

2 Asegúrese de que el medidor que está añadiendo esté en comunicación con el ordenador.

(Consulte Conexión de dispositivos en la página 26,  para ver los pasos para la conexión).

3 Haga clic en Devices  (Dispositivos) para acceder al área de trabajo Devices (Dispositivos) del

paciente.

4 Haga clic en el botón ADD DEVICE  (Añadir dispositivo).
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5 Seleccione Blood Glucose Meter  (Medidor de glucosa). Aparece el asistente Add Blood

Glucose Meter (Añadir medidor de glucosa).

6 Haga clic en el botón de opción para seleccionar la marca correcta del medidor.

7 Haga clic en NEXT (Siguiente). Aparece la página Meter Model  (Modelo del medidor); esta

página será diferente según el fabricante del medidor.

8 Haga clic para seleccionar el modelo de medidor que desea añadir.
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9 Haga clic en NEXT (Siguiente). Aparece la página Communication Options (Opciones de

comunicación).

NOTA: Sólo pueden seleccionarse las opciones válidas para el medidor que se está

añadiendo.

10 Haga clic en el menú desplegable Choose Port  (Elegir puerto) y seleccione el puerto del

ordenador al que se conecta el dispositivo ComLink, Paradigm Link o USB CareLink. Si no está

seguro de qué puerto elegir, seleccione Auto Detect (or USB)  (Detectar automáticamente [o

USB]).

11 Haga clic en NEXT Siguiente. Aparece la página Test Connection  (Comprobar conexión).

12 Siga las instrucciones para el medidor y haga clic en TEST (Comprobar).
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Aparece un mensaje que le informa si la conexión ha sido satisfactoria. Si ha sido así, vaya al

siguiente paso.

Si no lo ha sido, asegúrese de que el hardware entre el dispositivo y el ordenador esté

correctamente conectado. Además, haga clic en BACK (Atrás) en el asistente para asegurarse

de que los datos introducidos sean correctos.

13 Haga clic en DONE  (Finalizar).

Se añade el medidor a la lista Active Devices (Dispositivos activos) del paciente.

Cómo activar o desactivar un dispositivo

Los dispositivos del paciente pueden moverse entre las listas Active Devices (Dispositivos

activos) e Inactive Devices (Dispositivos inactivos) según sea necesario. Un dispositivo debe

estar activo para poder leer datos de él.

Puede tener cuantos medidores desee en la lista Active Devices (Dispositivos activos), pero

sólo puede tener una bomba. Asegúrese de que desea desactivar la bomba activa actual antes

de añadir una nueva.

Cómo desactivar un dispositivo

1 Haga clic en la ficha del paciente o haga doble clic sobre su nombre en la tabla Patient

Lookup (Búsqueda de pacientes).

2 Haga clic en Devices  (Dispositivos) para acceder al área de trabajo Devices (Dispositivos) del

paciente. Es posible que los dispositivos aparezcan en la lista con el nombre de un

dispositivo equivalente. Consulte el apartado Dispositivos compatibles en la página 2.

3 Haga clic en >> make this device inactive  (desactivar este dispositivo) debajo del

dispositivo que desee desactivar. El dispositivo pasará a la lista Inactive Devices  (Dispositivos

inactivos).

Cómo activar un dispositivo

1 Haga clic en la ficha del paciente o haga doble clic sobre su nombre en la tabla Patient

Lookup (Búsqueda de pacientes).

2 Haga clic en el botón Devices  (Dispositivos). Aparece el área de trabajo Devices

(Dispositivos) del paciente.

Es posible que los dispositivos aparezcan en la lista con el nombre de un dispositivo

equivalente. Consulte el apartado Dispositivos compatibles en la página 2.

3 Haga clic en >> activate this device (activar este dispositivo) debajo del dispositivo que

desee activar.

El dispositivo pasará a la lista Active Devices (Dispositivos activos).
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Cómo borrar un dispositivo

Los pasos descritos a continuación borrarán un dispositivo y sus datos del área de trabajo

Devices (Dispositivos) y del programa CareLink Pro:

1 Haga clic en la ficha del paciente o haga doble clic sobre su nombre en la tabla Patient

Lookup (Búsqueda de pacientes).

2 Haga clic en Devices  (Dispositivos) para acceder al área de trabajo Devices  (Dispositivos) del

paciente.

Es posible que los dispositivos aparezcan en la lista con el nombre de un dispositivo

equivalente. Consulte el apartado Dispositivos compatibles en la página 2.

3 Asegúrese de que el dispositivo se encuentre en la lista Inactive Devices  (Dispositivos

inactivos). Si no es así, haga clic en >> Inactivate this device (Desactivar este dispositivo) en

la lista actual.

4 Haga clic en >> delete this device  (borrar este dispositivo) debajo del dispositivo que desee

borrar. Aparecerá un mensaje que le advierte de que se borrarán del registro del paciente el

dispositivo y todos sus datos.

5 Haga clic en YES  (Sí) para borrar el dispositivo.

El dispositivo y sus datos se borran del área de trabajo Devices  (Dispositivos) y del programa

CareLink Pro. Los datos de este dispositivo ya no están disponibles para su uso en informes.

Cómo leer los datos de un dispositivo

Una forma de obtener los datos de un dispositivo es conectarse a la cuenta existente del

programa CareLink Personal del paciente. (Consulte Conexión al programa CareLink Personal en

la página 23).  Otra forma es leerlos directamente del dispositivo, tal como se describe en este

capítulo.

El programa CareLink Pro puede leer los datos del dispositivo de un paciente si  el  dispositivo

está en la lista Active Devices (Dispositivos activos) y está en comunicación con el ordenador.

Una vez obtenidos los datos, puede utilizarlos para crear informes que ayuden a evaluar la

gestión del tratamiento del paciente. Consulte Acerca de los informes en la página 46  para ver

una breve descripción de los informes disponibles.

CareLink Pro puede recopilar los siguientes datos de una bomba de insulina:

• Diversos parámetros de la bomba, como el modo de alerta, el volumen de los pitidos y la

presentación de la hora

• Cantidades de insulina basal administradas

• Episodios de bolus y cantidades administradas

• Entradas de la función Bolus Wizard

• Cantidades de cebado

• Períodos de suspensión
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• Lecturas de glucosa del sensor durante un período de tiempo, en bombas con funciones de

sensor

El sistema también puede reunir datos de sistemas Guardian REAL-Time, incluyendo los

siguientes:

• Lecturas de los valores del sensor (Sen)

• Valores de coeficiente del sensor

• Factores de calibración del sensor

• Marcadores de comida

• Inyecciones de insulina

Además, diversa información almacenada en un medidor de glucosa en sangre puede

descargarse al  programa durante una lectura del dispositivo.

ADVERTENCIA: Cancele o termine los bolus activos o los índices basales temporales y

resuelva las alarmas activas. Se suspenderá el funcionamiento de la bomba durante la

lectura. Una vez concluida la lectura, asegúrese de que se haya reanudado el
funcionamiento de la bomba.

PRECAUCIÓN: No utilice el control remoto de la bomba durante la lectura de la misma. Si

la carga de la pila de la bomba está baja, la bomba no enviará datos al  PC. Sustituya la
pila si el indicador de estado muestra que la carga de la pila está baja.

1 Haga clic en la ficha del paciente o haga doble clic sobre su nombre en la tabla Patient

Lookup (Búsqueda de pacientes).

2 Asegúrese de que el dispositivo del paciente esté en comunicación con el ordenador.

(Consulte Conexión de dispositivos en la página 26).

3 Haga clic en Devices  (Dispositivos) para acceder al área de trabajo Devices  (Dispositivos) del

paciente.

Es posible que los dispositivos aparezcan en la lista con el nombre de un dispositivo

equivalente. Consulte el apartado Dispositivos compatibles en la página 2.

4 Localice el dispositivo del que desea obtener datos en la lista Active Devices (Dispositivos

activos) y asegúrese de que los datos del campo Choose port (Elegir puerto) sean correctos.

Para las bombas, haga clic en el menú desplegable Amount of Data (Cantidad de datos) y

seleccione la cantidad de datos de la bomba que desea que lea el programa CareLink Pro.

5 Haga clic en el botón READ DEVICE  (Leer dispositivo) asociado.

6 Siga las instrucciones específicas del dispositivo y haga clic en OK (Aceptar).

7 El programa CareLink Pro muestra una barra de progreso que se actualiza para mostrar el

porcentaje completado de la lectura del dispositivo.
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Si hace clic en CANCEL  (Cancelar) durante la lectura del dispositivo, se mostrará un mensaje

para advertirle de que si se cancela la acción podrían perderse todos los datos leídos hasta

ese momento. Necesitará hacer clic en el botón READ DEVICE  (Leer dispositivo) para reiniciar

el proceso de carga.

- Para cancelar el proceso, haga clic en YES  (Sí).

- Para continuar la lectura de los datos del dispositivo, haga clic en NO.

Cuando el programa concluya la lectura de los datos del dispositivo, aparecerá un mensaje

que confirma que la lectura del dispositivo ha finalizado.

8 Haga clic en OK (Aceptar)).

- Para las bombas de insulina, siga las instrucciones para sacarlas del modo de suspensión.

Si CareLink Pro no puede obtener datos del dispositivo, consulte Resolución de problemas

para obtener más ayuda.
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6

Área de trabajo Reports (Informes)

El programa CareLink Pro proporciona una serie de informes que le ayudan a gestionar mejor

el tratamiento de diabetes de los pacientes. La información contenida en cada informe se

basa en los datos que obtiene de los dispositivos de los pacientes y sus cuentas del programa

CareLink Personal.

Los informes pueden generarse en la pantalla,  enviarse directamente a una impresora o

guardarse como archivos TIFF o PDF que puede adjuntar a una historia clínica electrónica.

Puede generar varios tipos de informes en una sola operación.

Los datos mostrados en estos informes proceden de los dispositivos del paciente, de su

cuenta del programa CareLink Personal o de ambas fuentes.

NOTA: En la guía de referencia para informes se presenta información más detallada
sobre los componentes de los informes, así  como ejemplos de los informes. Puede acceder

a la Guía de referencia para informes a través del  programa CareLink Pro dirigiéndose a

Help>View Report Reference Guide (Ayuda>Ver Guía de referencia para informes) (PDF), y
seleccionando el idioma adecuado.
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Antes de empezar

Si desea reflejar un período de tiempo en un informe, debe tener los datos del dispositivo del

paciente correspondientes a dicho período. Es posible que también necesite tener el

dispositivo del paciente conectado al ordenador para obtener datos recientes antes de

generar informes.

Lea atentamente el paso Comprobación de la configuración de los informes  antes de

generar un informe. Ahí puede configurar detalladamente un informe para registrar los datos

que desee del paciente.

Crear informes

Las siguientes secciones le ayudarán a entender mejor los informes que puede consultar y el

proceso que se utiliza para generarlos.

Si está familiarizado con el proceso de generación de informes y sabe qué informes le gustaría

ejecutar, puede comenzar a generar informes.

Cómo abrir el área de trabajo Reports (Informes)

Haga clic en la ficha del paciente o haga clic en el botón Open Patient  (Abrir paciente)  y

haga doble clic en su nombre.

Aparece el área de trabajo Reports  (Informes).

NOTA: Para asegurarse de que dispone de los datos del dispositivo más recientes
procedentes de la cuenta del programa CareLink Personal del paciente, haga clic en SYNC

DATA (Sincronizar datos).

Seleccionar el período del informe

1 Para cambiar el período de tiempo reflejado en los informes, haga clic en el menú

desplegable Duration  (Duración) y seleccione la cantidad de tiempo que desee. (La duración

máxima es de 12 semanas).

2 Las fechas desde y hasta se definen automáticamente, a menos que seleccione la opción

custom date range  (intervalo de fechas personalizado).

NOTA: Si selecciona un intervalo de fechas superior al permitido, se mostrará un

mensaje de error. Ajuste la duración o las fechas.

Si desea un intervalo de fechas personalizado, haga clic en los menús desplegables From

(Desde) o Through (Hasta) y seleccione el día, el mes o el año que desee.
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Calendario de datos

El área del calendario de datos del área de trabajo Reports (Informes) muestra un intervalo de

tres meses de información para informes.

Las barras azules representan datos del dispositivo. La barra naranja representa el período del

informe que seleccionó. Si existe una superposición de los datos de los dispositivos y del

período de informe, significa que dispone de datos de parte del período del informe mostrado

o de todo el período.

El área del calendario de datos muestra inicialmente los tres meses más recientes. Para ver

otros meses, haga clic en los botones de flecha  situados a ambos extremos de los meses.

Cómo seleccionar los datos originales que se desea incluir

1 Si el paciente utiliza un medidor de glucosa vinculado a su bomba de insulina, haga clic para

elegir una de las siguientes opciones para generar un informe con los datos del medidor de

glucosa:

- in the pump (en la bomba):  las ventajas de esta selección son que sólo tiene que leer los

datos de la bomba del paciente, que las lecturas de glucosa en sangre llevan la fecha y la

hora registradas por la bomba y que las lecturas se vinculan directamente a los cálculos

de la función Bolus Wizard utilizados. Un inconveniente es que si existen problemas de

comunicación entre la bomba y el medidor vinculado, es posible que no se incluyan en

el informe las lecturas de glucosa en sangre correspondientes a ese período de tiempo.

Además, para las bombas MiniMed Paradigm anteriores al Modelo 522/722, no se

incluyen en los informes las lecturas de glucosa en sangre derivadas de los cálculos de la

función Bolus Wizard sobre las que no se actúa.

- In the link meter(s) (en el medidor vinculado): la ventaja de esta selección es que se

incluyen en el informe todas las lecturas guardadas en el medidor vinculado. El

inconveniente es que para relacionar los datos del medidor y de la bomba, debe haberse

asegurado de que los relojes de la bomba y del medidor están sincronizados entre sí.

También debe leer los datos de la bomba y del medidor vinculado por separado.

2 Para añadir los datos de un dispositivo a los informes, seleccione la casilla de verificación

situada junto al dispositivo en cuestión.

No puede añadir dispositivos que hayan sido excluidos a consecuencia de la selección

realizada en el paso 1. Para cambiar esto, seleccione la otra opción del medidor vinculado.

3 Para excluir los datos de un dispositivo de los informes, elimine la marca de la casilla de

verificación situada junto al dispositivo en cuestión.
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No puede eliminar las marcas de verificación relacionadas con la opción seleccionada en el

paso 1. Para cambiar esto, seleccione la otra opción del medidor vinculado.

Comprobar los datos de los dispositivos

1 Compruebe en el área del calendario de datos del área de trabajo Reports (Informes) si la

barra naranja que representa el período del informe se superpone con las barras azules que

representan los datos de los dispositivos.

2 Si las barras se superponen en todo el período del informe, dispone de datos para los

informes. Puede hacer clic en NEXT (Siguiente) e ir al apartado Comprobar la configuración de

los informes en la página 43.

3 Si las barras no se superponen, o si la superposición no es suficiente, tiene dos opciones:

- Ajustar el período del informe.

- Obtener datos adicionales de los dispositivos.

Cómo obtener datos adicionales de los dispositivos

1 Para obtener más datos de un dispositivo, haga clic en el botón READ DEVICE  (Leer

dispositivo) asociado al dispositivo.

Se muestra la barra Read Device (Leer dispositivo).

ADVERTENCIA: Cancele o termine los bolus activos o los índices basales temporales y
resuelva las alarmas activas. Se suspenderá el funcionamiento de la bomba durante la

lectura. Una vez concluida la lectura, asegúrese de que se haya reanudado el

funcionamiento de la bomba.

PRECAUCIÓN: No utilice el control remoto de la bomba durante la lectura de la

misma. Si la carga de la pila de la bomba está baja, la bomba no enviará datos al
PC. Sustituya la pila si la pantalla de estado del dispositivo indica que la carga de la

pila está baja.

2 Compruebe que los datos del campo Choose port  (Elegir puerto) sean correctos para este

dispositivo.

Para cambiar este valor, haga clic en el menú desplegable del campo y seleccione un valor

diferente.

3 Asegúrese de que el dispositivo está conectado al ordenador.
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4 Si el dispositivo es una bomba, puede especificar la cantidad de datos que desea obtener de

ella. Haga clic en el menú desplegable Amount of Data  (Cantidad de datos) y seleccione una

cantidad.

NOTA: Si selecciona All available data (Todos los datos disponibles),  el sistema leerá
todos los datos Se sobrescribirán los datos duplicados que haya en el sistema.

5 Haga clic en READ DEVICE (Leer dispositivo). Lea detenidamente el mensaje mostrado, ya

que proporciona instrucciones específicas para leer la bomba.

6 Siga las instrucciones y haga clic en OK  (Aceptar).

Se muestra la barra de progreso de lectura del dispositivo.

Puede decidir cancelar la lectura en cualquier momento haciendo clic en CANCEL  (Cancelar).

Aparecerá un mensaje que confirma que la lectura ha finalizado.

7 Haga clic en OK (Aceptar).

Los datos del dispositivo se visualizarán entonces en el calendario de datos.

8 Haga clic en NEXT (Siguiente) en la parte superior del área de trabajo Reports (Informes).

Se muestra el paso Verify Report Settings (Comprobar la configuración de los informes). Esto

le permite asegurarse de que la configuración para este paciente es correcta antes de

generar el informe.

Comprobar la configuración de los informes

1 Asegúrese de que los valores del área Glucose Target (Objetivo de glucosa) son los

deseados. Escriba estos valores o haga clic en las flechas arriba o abajo de los campos Low

(mínimo) y High (máximo) para aumentar o disminuir los valores.

NOTA: Los marcadores de lectura de medidores (||  |)  se muestran en la línea

cronológica de despertar y hora de dormir,  además de en la línea cronológica de los

marcadores de comida. Como algunos de los informes se basan en datos encontrados
dentro de las horas de las comidas definidas, horas de despertar y de dormir,  es

importante que se agrupen correctamente un evento Bolus Wizard del paciente y los

marcadores de lectura de medidores.

2 Para añadir un nuevo período de comida, haga clic en ADD MEAL  (Añadir comida). Para

modificar un período de comida existente, haga clic en cualquier punto del período de

comida a lo largo de la línea temporal.

El editor Meal Period (Período de comida), situado bajo la línea temporal, se activa.

NOTA: Puede tener hasta cinco períodos de comida. Los períodos predeterminados son
desayuno, comida y cena.
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3 Introduzca texto o haga clic en las flechas para seleccionar la configuración que desee.

Si sólo desea utilizar esta configuración para esta comida, elimine la marca de la casilla de

verificación Use these parameters for all of this patient's meals (utilizar estos

parámetros para todas las comidas de este paciente).

- Meal Name (Nombre de la comida):  nombre que desea asignar al período de comida.

- Meal Time Period (Período de tiempo de comida):  horas entre las que tiene lugar la

comida.

- Pre-Meal BG Target (Objetivo de glucosa en sangre antes de la comida) (mg/dl o

mmol/l):  límites inferior y superior del intervalo del objetivo de glucosa antes de la

comida del paciente.

- Pre-Meal Analysis Period (Período de análisis previo a la comida): período de tiempo

en el que la glucosa será analizada, antes del inicio de una comida. Las lecturas de

glucosa registradas durante este tiempo se utilizan para un análisis de informe detallado.

- Post-Meal BG Target (Objetivo de glucosa en sangre después de la comida) (mg/dl

o mmol/l):  límites inferior y superior del intervalo del objetivo de glucosa después de la

comida del paciente.

- Post-Meal Analysis Period (Período de análisis posterior a la comida):  período de

tiempo en el que la glucosa será analizada después de una comida. Las lecturas de

glucosa registradas durante este tiempo se utilizan para un análisis de informe detallado.

Puede cambiar la duración de un período de comida existente o del período de

despertarse o acostarse haciendo clic en los tiradores inicial o final y arrastrándolos y

soltándolos en la línea temporal.

NOTA: Los períodos de las comidas no pueden superponerse, pero las líneas inicial y
final de los distintos períodos pueden estar contiguas. Los períodos de comida deben

tener una duración de al menos 60 minutos.

4 Para utilizar la configuración de esta comida para las demás comidas del paciente, asegúrese

de que esté seleccionada la casilla de verificación situada junto a la opción Use these

parameters for all of this patient’s meals  (Utilizar estos parámetros para todas las comidas

de este paciente).

5 Cuando haya finalizado de crear o editar un período de comida, haga clic en SAVE  (Guardar).

6 Para borrar un período de comida, haga clic en DELETE MEAL  (Borrar comida). Haga clic en

DELETE (Borrar) cuando se le pida que confirme la acción.

7 El programa CareLink Pro puede recordar esta configuración para este paciente la siguiente

vez que genere un informe para él. Para guardar la configuración para este paciente, haga

clic en SAVE SETTINGS (Guardar configuración).

8 Haga clic en NEXT (Siguiente) en la parte superior del área de trabajo Reports (Informes).
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Este es el paso Select and Generate Reports (Seleccionar y generar informes) del proceso.

Proporciona una lista de tipos de informes y una tabla de datos que le ayuda a incluir o

excluir ciertos días de datos de los informes Daily Detail Report (Informe de detalles diarios).

NOTA: Para modificar la presentación de la tabla de datos, haga clic en >> customize
columns (personalizar columnas).  Consulte el apartado Preferencias para la generación

de informes en la página 17.

9 Para imprimir una pantalla, haga clic en el icono PRINT (Imprimir) .

Seleccionar los tipos de informes y las fechas de inclusión

1 Seleccione la casilla de verificación situada junto a los informes que desee incluir en el

conjunto de informes.

2 Si se han leído los datos de una bomba o de un monitor Guardian más de una vez durante

este período de informe, es posible que haya varias imágenes del dispositivo:

a. Asegúrese de que esté seleccionada la casilla de verificación situada junto a la opción

Device Settings Snapshot  (Imagen de la configuración del dispositivo).

b. Haga clic en la flecha de menú desplegable y seleccione la fecha y la hora de una

imagen.

- Bombas:  seleccione una imagen de la bomba del paciente.

- Guardian:  seleccione una imagen del monitor Guardian del paciente.

CareLink Pro Guía del usuario   Área de trabajo Reports (Informes) 45



Si el campo aparece atenuado, significa que no hay imágenes disponibles para el período del

informe.

3 Recorra la tabla de datos para revisar la información de los informes Daily Detail Report

(Informe de detalles diarios) disponible.

- Puede ordenar los datos en cada columna. Haga clic en el encabezado de la columna

para ordenar los datos en orden ascendente. Haga clic de nuevo en el encabezado para

ordenar los datos en orden descendente.

NOTA: Si no hay datos para una fecha concreta, no podrá seleccionar esa fecha.

4 Seleccione la casilla de verificación de las filas de la tabla de datos para las fechas para las

que desee un informe Daily Detail Report (Informe de detalles diarios).

- Para incluir o excluir todas las fechas del informe de detalles diarios con un solo clic,

seleccione la casilla de verificación situada en la parte superior de la columna de casillas

de verificación de la tabla de datos.

Generar informes

1 Una vez que haya verificado las selecciones para los informes, haga clic en GENERATE

REPORTS (Generar informes) en la parte superior del área de trabajo Reports (Informes).

Se presenta una lista de opciones.

2 Seleccione una opción para mostrar una vista previa de los informes, imprimirlos o

guardarlos.

Si ha seleccionado la opción Preview (Vista previa), aparecerá la ventana Preview (Vista

previa).

3 Haga clic en los botones de flecha para desplazarse por los informes que tengan varias

páginas.

4 Haga clic en uno de los otros botones en la parte superior de la ventana Preview (vista

previa) para guardar o imprimir los informes.

5 Para cerrar esta ventana, haga clic en el botón Close (Cerrar)  situado en la esquina

superior derecha de la ventana.

Acerca de los informes

Este apartado proporciona una descripción de cada informe. En la guía de referencia para

informes se presenta información más detallada sobre los componentes de los informes, así

como ejemplos de los informes. Puede acceder a la guía de referencia para informes a través

de CareLink Pro:
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1 Help > View Report Reference Guide (PDF) (Ayuda > Ver guía de referencia para

informes [PDF]).

2 Seleccione un idioma para la guía de referencia para informes.

Los informes del programa CareLink Pro tienen los siguientes elementos en común:

• Encabezado del informe:  el encabezado del informe contiene información de identificación,

como el nombre del informe, el nombre del paciente y el origen de los datos.

• Niveles de carbohidratos y glucosa en sangre: en los gráficos y tablas las unidades de

carbohidratos se muestran en cursiva y los niveles de glucosa en sangre se muestran en

negrita.

• Datos del fin de semana:  los días del fin de semana se muestran en negrita para poder

identificarlos fácilmente.

• Leyendas:  en la parte inferior de cada informe se muestra una leyenda de los símbolos.

Aunque un símbolo puede ser utilizado en varios informes, las leyendas son exclusivas para

cada informe.

Informe Adherence (Cumplimiento)

Este informe Adherence presenta datos que describen cómo se utilizan las bombas de insulina

y los sensores, así como el comportamiento del paciente en relación con su tratamiento.

Responde a la pregunta “¿Había suficientes datos para obtener una idea precisa de cómo

utiliza el  paciente la bomba de insulina y el  sensor, si procede?”. También responde a la

pregunta “¿Cumplen los pacientes el  tratamiento tal  como se les ha indicado?”. Indica

también si  puede ser necesario hablar con el paciente acerca de la forma en que está

controlando su diabetes.

Informe Sensor and Meter Overview (Resumen del medidor y del sensor)

El informe Sensor and Meter Overview Report (Informe de resumen del medidor y del sensor)

proporciona una representación gráfica de los niveles diarios y las medias de glucosa del

paciente, incluido un desglose por horas durante 24 horas y su relación con las comidas y los

patrones de sueño. También se incluyen estadísticas sobre las lecturas de glucosa y el uso de

insulina por el paciente.

Si se dispone de datos del sensor se genera un análisis similar de dichos datos como primera

página del informe. Si no se dispone de datos del sensor, la primera página será la página de

análisis de los datos del medidor.

Las páginas finales del informe muestran el nivel día a día y la calidad del control de la

glucemia, de los carbohidratos y de la insulina del paciente. Cada página muestra la variación

de ese control cada día durante todo el período del informe, con un máximo de 14 días por

página.
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Informe Logbook (Libro de registro)

El informe Logbook Report (Informe Libro de registro) proporciona datos de insulina, de

carbohidratos y de glucosa del medidor para cada día del período del informe. Ofrece un

diario de los eventos registrados cada hora, así como los promedios y totales diarios. Cada

página contiene un máximo de 14 días. Si el período del informe es superior a 14 días, se

generarán páginas adicionales.

Device Settings Snapshot (Imagen de la configuración del dispositivo)

Este informe presenta una imagen de la configuración de la bomba o del monitor Guardian

REAL-Time del paciente para una fecha y una hora específicas. Puede ayudarle a comprender

otros informes o simplemente documentar la configuración del paciente.

La configuración de la bomba o del monitor sólo se registra durante la lectura del dispositivo.

Si no se ha leído el dispositivo durante el período del informe, no se dispondrá de ajustes de

configuración.

Informe de detalles diarios

El informe Daily Detail Report (Informe de detalles diarios) muestra los datos de glucosa, las

cantidades de carbohidratos y la utilización de insulina por el paciente para el día

seleccionado. Se genera un informe diferente para cada día seleccionado en la tabla de datos.

El informe Daily Detail  Report (Informe de detalles diarios) proporciona información detallada

de cada día seleccionado. Le permite centrarse en un día determinado si piensa que ese día

ocurrió algo importante para el tratamiento del paciente.

Cómo exportar datos

Puede exportar datos de dispositivos que el programa CareLink Pro haya adquirido y

guardado. Esto le permite disponer de todos los datos de los dispositivos de un paciente para

utilizarlos para generar estadísticas o crear informes o gráficos especializados. El archivo .csv

puede importarse en Microsoft Excel o en ciertos programas de estadísticas clínicas en los que

puede manipular los datos.

El archivo .csv contiene datos que registran las acciones del dispositivo. Por ejemplo, presenta

una lista del registro de las lecturas del medidor, la bomba que recibió el valor de la lectura

del medidor o el  cambio del índice basal.

NOTA: Se trata de una función avanzada y requiere que esté familiarizado con los datos
sin procesar del dispositivo. También requiere un dominio del programa de software en el

que importe el  archivo .csv.

Siga los pasos descritos a continuación para utilizar la función de exportación del programa

CareLink Pro:
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1 Haga clic en la ficha del paciente o haga clic en el botón Open Patient  (Abrir paciente)  y

haga doble clic en su nombre.

2 Asegúrese de que aparece el área de trabajo Reports (Informes).

3 Utilice los campos Duration  (Duración) o From/Through  (Desde/Hasta) para definir las

fechas y la duración del informe.

La duración máxima que puede seleccionar es 12 semanas.

4 Haga clic en el vínculo export selected data (exportar datos seleccionados).

Aparece el cuadro de diálogo Export Data to CSV File (Exportar datos a archivo CSV).

5 Vaya a la ubicación donde desea guardar el archivo .csv en su ordenador. Si desea cambiar el

nombre del archivo, escríbalo en el cuadro File name (Nombre del archivo).

6 Haga clic en SAVE  (Guardar).

NOTA: Si desea más información sobre los datos presentados en los archivos CSV,

consulte el apéndice de datos CSV.

El archivo .csv ya está guardado en el ordenador en la ubicación seleccionada. A

continuación puede importarlo en cualquier programa que sea compatible con este tipo de

archivo.
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7

Administración del programa

Es importante que haga periódicamente una copia de seguridad de la base de datos del

programa CareLink Pro. La base de datos almacena todos los datos del programa que se

hayan acumulado en los registros de pacientes, incluida la información del perfil,  los datos

procedentes de los dispositivos y la configuración de los informes.

También es importante que tenga la versión más reciente del programa CareLink Pro.

Periódicamente estarán disponibles versiones actualizadas que pueden contener importantes

mejoras. Puede elegir buscar actualizaciones o ser avisado cuando éstas estén disponibles.

Actualizaciones del software

En ocasiones habrá actualizaciones del programa CareLink Pro. Cuando se muestre un aviso

de una actualización, siga los pasos descritos a continuación para descargar la versión más

reciente del programa.

NOTA: Antes de aplicar una actualización del programa debe hacerse una copia de

seguridad de la base de datos. Consulte el apartado Hacer una copia de seguridad de la

base de datos en la página 52.

1 Asegúrese de que dispone de una conexión a Internet y de que ésta está activa en el

ordenador.

2 Se mostrará el mensaje de actualización del programa CareLink Pro cuando exista una

actualización del programa. Le ofrece la posibilidad de descargar la actualización.

3 Haga clic en DOWNLOAD  (Descargar). (Si hace clic en CANCEL [Cancelar], se cerrará el aviso

de actualización. Puede descargar la actualización más adelante).

Aparecerá un mensaje de advertencia que recomienda hacer una copia de seguridad de la

base de datos.
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4 Haga clic en YES  (Sí) para crear una copia de seguridad de la base de datos (consulte el

apartado Hacer una copia de seguridad de la base de datos en la página 52,  para este

procedimiento). Haga clic en NO si ya ha hecho copia de seguridad de los datos.

Aparecerá un mensaje que confirma que se ha descargado la nueva versión del programa

CareLink Pro.

5 Para comenzar a utilizar la versión más reciente del programa CareLink Pro, haga clic en YES

(Sí) para cerrar y volver a abrir el programa. Haga clic en NO  si prefiere esperar antes de

reiniciar el programa CareLink Pro.

Cómo desactivar las actualizaciones automáticas

Si no desea recibir una notificación automática de las actualizaciones del programa CareLink

Pro, siga los pasos descritos a continuación:

1 Seleccione Tools  > Options  (Herramientas > Opciones).

2 Haga clic en la ficha General (Generales).

3 En la sección Communications (Comunicaciones), elimine la marca de la casilla de verificación

situada junto a la opción Automatically check for software updates  (Comprobar

automáticamente la disponibilidad de actualizaciones del programa).

Cómo comprobar manualmente la disponibilidad de actualizaciones

Puede comprobar manualmente la disponibilidad de actualizaciones del programa CareLink

Pro en cualquier momento.

NOTA: Antes de aplicar una actualización del programa debe hacerse una copia de

seguridad de la base de datos. Consulte el apartado Hacer una copia de seguridad de la

base de datos en la página 52.

1 Asegúrese de que dispone de una conexión a Internet y de que ésta está activa en el

ordenador.

2 Seleccione Tools > Check for Software Updates  (Herramientas > Comprobar la

disponibilidad de actualizaciones del programa).

3 Si no hay actualizaciones disponibles, se mostrará el mensaje correspondiente. Si hay una

actualización disponible, se mostrará un mensaje de actualización del programa CareLink Pro.

4 Siga el procedimiento descrito en el apartado Actualizaciones del software en la página 50.

Copia de seguridad y restauración de la base de datos

Se recomienda establecer un plan periódico de copias de seguridad de la base de datos. Esto

ayudará a asegurarse de que se realicen de forma periódica y reducirá al mínimo el riesgo de

pérdida de datos.
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Si va a hacer una copia de seguridad o una restauración de la base de datos, el  programa le

avisará si  hay usuarios activos del programa en otros ordenadores.

Hacer una copia de seguridad de la base de datos

Los siguientes pasos le permiten hacer una copia de seguridad de la base de datos actual en la

ubicación que usted seleccione.

1 Asegúrese de que todos los registros de pacientes están cerrados.

2 Seleccione Tools > Backup Database (Herramientas > Copia de seguridad de la base de

datos).

NOTA: Las copias de seguridad de la base de datos pueden guardarse en una unidad
de red o en un medio de almacenamiento extraíble (DVD, CD, unidad USB, etc.).

3 Vaya a la ubicación donde desea guardar el archivo de copia de seguridad en su ordenador.

Si desea cambiar el nombre del archivo de copia de seguridad, escríbalo en el cuadro File

name (Nombre del archivo).

4 Haga clic en Save (Guardar). Mientras se guarda la base de datos aparece una barra de

progreso.

Cuando la copia de seguridad finalice, aparecerá un mensaje.

5 Haga clic en OK (Aceptar) para cerrar el mensaje.

Restaurar la base de datos

Puede ser necesario sustituir la base de datos actual en caso de que no sea posible acceder

a ella o utilizarla. Cuanto más reciente sea la copia de seguridad, menos datos se perderán

si sustituye la base de datos.

PRECAUCIÓN: Cuando se restaura la base de datos con una copia de seguridad, se pierden

todos los datos nuevos creados en la base de datos actual desde que se realizara la copia

de seguridad seleccionada.

Los siguientes pasos le permiten seleccionar una copia de seguridad para sustituir la base de

datos actual.

1 Asegúrese de que todos los registros de pacientes están cerrados.

2 Seleccione Tools > Restore Database (Herramientas > Restaurar la base de datos).

3 Seleccione el archivo de copia de seguridad que desee utilizar para sustituir la base de datos

actual (generalmente el más reciente).

4 Haga clic en Open  (Abrir). Se muestra un mensaje de aviso que le recuerda que pueden

perderse datos si continúa la restauración de la base de datos.

5 Haga clic en OK (Aceptar) para continuar. Mientras se restaura la base de datos aparece una

barra de progreso.
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Cuando se haya restaurado la base de datos, aparecerá un mensaje.

6 Haga clic en OK (Aceptar) para cerrar el mensaje.

Cuando el programa no está disponible

Si intenta iniciar el programa mientras otro usuario está realizando una copia de seguridad o

una restauración, recibirá un mensaje avisándole de que el programa no está disponible. No

podrá acceder al programa hasta que haya finalizado la operación.

Realice una de las acciones siguientes:

• Espere a que finalice el proceso y a que el programa esté disponible.

• Haga clic en CANCEL (Cancelar) e inténtelo de nuevo más tarde.
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8

Resolución de problemas

Este capítulo tiene por finalidad ayudarle a resolver los problemas que puedan surgir durante

el uso del programa CareLink Pro. También contiene instrucciones para desinstalar CareLink

Pro si  es necesario.

Errores generales de uso del programa

Si intenta descargar una actualización del programa a través de Internet, es posible que

aparezca un mensaje que le indique que no tiene suficientes privilegios para ello. Debe tener

privilegios administrativos para descargar actualizaciones del programa CareLink Pro.

1 Cierre el programa CareLink Pro y reinicie el ordenador.

2 Pida a alguien que tenga privilegios administrativos que inicie una sesión en el ordenador.

3 Siga las instrucciones descritas en el apartado Actualizaciones del software en la página 50.

No hay conexión con la base de datos

Un mensaje de error que indica que no está conectado a la base de datos indica una de las

posibilidades siguientes:

• Se ha movido la base de datos. La base de datos debe estar ubicada en el mismo lugar

seleccionado durante la instalación del programa CareLink Pro. Si se ha movido, deberá

devolverse a la ubicación seleccionada durante la instalación.

• No está conectado a la unidad de red en la que se encuentra la base de datos. Si la base de

datos está ubicada en una unidad de red, en ocasiones la red podría experimentar problemas

que le impidan acceder a la unidad. Póngase en contacto con el departamento informático

para solicitar ayuda para volver a conectarse a la unidad de red en la que se encuentra la

base de datos.
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Ha olvidado la contraseña del centro para el programa CareLink Pro

Si nadie recuerda la contraseña que utiliza el  centro médico para iniciar una sesión en el

programa CareLink Pro, se deberá reinstalar el programa y crear una nueva base de datos. Una

vez haya reinstalado el programa, no podrá acceder a ninguna información de los pacientes

que estuviera almacenada en la base de datos anterior.  Guarde la contraseña que cree

durante la nueva instalación en algún lugar de la consulta, de forma que no pierda los datos

futuros.

Errores de lectura de dispositivos

Error Explicación

The selected serial port could not be opened. Another
operation might be in progress on that port. Please
wait until the port is  available, or select another port.
(No ha sido posible abrir el puerto en serie
seleccionado. Es posible que haya otra operación en
curso en ese puerto.  Espere a que el  puerto esté
disponible o seleccione otro puerto).

Compruebe que el puerto COM seleccionado no
esté siendo utilizado por otro programa o
seleccione un puerto diferente. Pruebe a reiniciar
el ordenador que está utilizando e intente leer el
dispositivo de nuevo. Es posible que el hardware
(cable, etc.)  conectado al puerto o el propio puerto
estén dañados. Conecte el hardware a otro puerto e
intente leer el dispositivo de nuevo para identificar
el problema.

Auto Detect could not find the device on any available
port. Please check the cable connection, device battery
& status and try again, or try specifying a serial  port. (La
función de detección automática no ha encontrado el
dispositivo en ningún puerto disponible. Compruebe la
conexión del cable y la batería y el estado del
dispositivo e inténtelo de nuevo, o pruebe a especificar
un puerto en serie).

Compruebe la conexión entre el cable y el PC y
asegúrese de que el estado de la batería del
dispositivo sea correcto. Si  es así,  pruebe a
especificar el puerto en serie del PC al que está
conectado el cable en lugar de seleccionar la
opción Auto Detect (Detección automática).

Device not found at selected serial port. Please check
the cable connection, device battery & status and try
again, try selecting a different port, or try to Auto
Detect the device. (No se ha encontrado el dispositivo
en el puerto en serie seleccionado. Compruebe la
conexión del cable y la batería y el estado del
dispositivo e inténtelo de nuevo, o pruebe a seleccionar
un puerto diferente o utilice la opción Auto Detect
[Detección automática]).

Compruebe la conexión entre el cable y el PC y
asegúrese de que el estado de la batería del
dispositivo sea correcto. Si  es así,  pruebe a
seleccionar un número de puerto en serie del PC
diferente o elija la opción Auto Detect (Detección
automática).

Unable to communicate with the device. Please ensure
you’ve attached and selected the correct device, check
the cable connection, device battery and status, and try
again. (No es posible establecer la comunicación con el
dispositivo. Asegúrese de que ha conectado y
seleccionado el dispositivo correcto, compruebe la
conexión del cable y la batería y el estado del
dispositivo e inténtelo de nuevo).

Compruebe todos los valores seleccionados para el
dispositivo leído,  incluidos el  nombre del
dispositivo, el número de serie y el tipo de
conexión. Asegúrese también de que el dispositivo,
el cable y el  PC están correctamente conectados.
Compruebe que el estado de la batería y de la
alarma del dispositivo es correcto. Intente leer el
dispositivo de nuevo.

Unexpected response… retrying (n%) (Respuesta
inesperada… intentándolo de nuevo [n%])

Se ha leído un valor inesperado del dispositivo. El
programa reintentará la comunicación hasta que
usted cancele la operación o se establezca la
comunicación.
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Error Explicación

The link device was found, but the device (<serial #>) is
not responding. Please verify the device’s serial
number, place the device closer to the link device to
minimize signal interference, check device battery and
status. (Se ha encontrado el dispositivo de Link pero el
(<N.º de serie>) no responde. Compruebe el número de
serie del dispositivo, aproxime el dispositivo al
dispositivo Link para reducir al mínimo la interferencia
de señal y compruebe la batería y el  estado del
dispositivo).

Compruebe que se ha introducido el número de
serie correcto. Si no es así,  vuelva a introducir el
número de serie correcto. Si el número de serie es
correcto, intente acercar el dispositivo de Link al
dispositivo de comunicación. Separe el dispositivo
Link y el dispositivo de comunicación de posibles
interferencias (como por ejemplo, otros dispositivos
de radiofrecuencia). Compruebe la potencia de la
batería del dispositivo y si carga una bomba de
insulina, compruebe el  estado de suministro de la
bomba.

This pump is delivering a temp basal. Please cancel the
temp basal or wait until it completes, and then try
again. (Esta bomba está administrando un basal
temporal. Cancele el basal temporal o espere a que éste
finalice y, a continuación, inténtelo de nuevo).

La bomba que está intentando leer está
administrando un basal temporal. Espere a que
finalice el  basal temporal para leer la bomba o
cancele el  basal temporal y, a continuación, lea la
bomba.

This device has active errors or alarms. Please clear the
alarms and try again. (Esta bomba tiene alarmas o
errores activos. Resuelva las alarmas e inténtelo de
nuevo).

Hay alarmas activas en la bomba que impiden su
lectura. Lea las instrucciones de la alarma para
resolverla. Resuelva la alarma e intente leer la
bomba de nuevo.

This pump is delivering a bolus. Please cancel the bolus
or wait until it completes, and then try again. (Esta
bomba está administrando un bolus. Cancele el bolus o
espere a que éste finalice y, a continuación, inténtelo de
nuevo).

La bomba que está intentando leer está
administrando un bolus. Espere a que finalice el
bolus para leer la bomba o cancele el bolus y, a
continuación, lea la bomba.

The device returned invalid entries; all data read will be
discarded. (El dispositivo ha devuelto entradas no
válidas; se desecharán todos los datos leídos).

Póngase en contacto con su representante local
(consulte Asistencia técnica en la página 2).

Errores en la creación de informes

Múltiples entradas de datos para la misma fecha

Si existen varias entradas de datos para la misma fecha y hora para el mismo dispositivo, el

programa considera que se trata de un conflicto que no puede resolver. Los informes creados

utilizando los datos de este dispositivo omitirán la parte coincidente de los datos.

Puede intentar ajustar el período del informe para omitir los datos coincidentes. O puede

borrar el dispositivo del programa y añadirlo de nuevo para borrar las lecturas previas.

El programa va a ignorar datos

Si se ha modificado la hora de un dispositivo y esto ha causado coincidencias o vacíos en los

datos de tres horas o más, el programa no incluirá esa parte de los datos al crear informes.

Errores en tareas de copia de seguridad y restauración

No puede bloquearse la base de datos

Esto significa que está utilizando el programa en un entorno multiusuario y que otros usuarios

están conectados. El programa no permitirá realizar una copia de seguridad de la base de

datos mientras otros usuarios puedan estar realizando tareas que podrían afectar a la base de

datos. Una vez que todos los demás usuarios hayan salido de CareLink Pro, podrá realizar la

copia de seguridad de la base de datos.
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No puede finalizar una copia de seguridad o una restauración de la base de datos

Otros usuarios no pueden conectarse y la copia de seguridad o restauración no puede

finalizar.  Póngase en contacto con su representante local (consulte Asistencia técnica en la

página 2).

Fallo en la restauración de la base de datos

El archivo de copia de seguridad de la base de datos que está intentando utilizar para el

proceso de restauración está dañado. Intente realizar la restauración con un archivo de copia

de seguridad diferente.

Desinstalación del software

Si necesita desinstalar el  programa CareLink Pro, siga los pasos indicados a continuación:

1 Abra el Panel de control a través del menú Inicio  de Windows.

2 Seleccione Agregar o quitar programas.  Se mostrará la ventana Agregar o quitar

programas.

3 Desplácese hasta Medtronic CareLink Pro  y haga clic en él.

4 Haga clic en Eliminar.  Aparecerá el asistente Install Shield.

5 Haga clic en Siguiente.  Aparecerá un mensaje pidiéndole que confirme que desea borrar la

aplicación.

6 Haga clic en Sí.  Se ejecutará el programa de desinstalación que borrará del ordenador el

programa y todos sus archivos. Cuando haya finalizado, aparecerá un mensaje en la pantalla

del asistente para confirmar la desinstalación.

7 Haga clic en Finalizar.
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9

Tabla de iconos

En la siguiente tabla se presentan los iconos y símbolos que aparecen en las etiquetas del

envase y en el equipo:

Descripción Icono

Uno por contenedor/envase (1X)

CD adjunto

Atención: Lea todas las advertencias y precauciones en
las instrucciones de uso.

Fecha de fabricación (año)

Número de catálogo

Conformité Européenne (Conformidad Europea). Este
símbolo indica que el  dispositivo cumple totalmente la
Directiva 93/42/CEE relativa a los productos sanitarios y
la Directiva R&TTE 1999/5/CE sobre equipos
radioeléctricos y equipos terminales de
telecomunicación.
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Datos de los archivos CSV

Cuando exporte datos de informes del programa CareLink Pro, se exportan en un archivo .csv.

Este archivo se puede importar en una aplicación de hoja de cálculo, como Microsoft Excel.

Consulte las definiciones de la columna de archivo CSV para ver una lista completa de los

datos que un archivo CSV puede contener.

El archivo CSV contiene el nombre y la ID de paciente, el período de informe, e identifica cada

dispositivo incluido en el informe.

Definiciones de los datos de las columnas

Encabezado de la columna Definición

Index (Índice) Orden en que se registraron los datos en el
dispositivo.

Date (fecha) Fecha en que se registraron los datos en el
dispositivo.

Time (hora) Hora en que se registraron los datos en el
dispositivo.

New Device Time (nueva hora del dispositivo) Nueva fecha y hora si se ha cambiado en el
dispositivo.

BG Reading (mg/dL or mmol/L) (valor de GS [mg/dL o
mmol/L])

Valor de glucosa en sangre registrado por el
medidor, Guardian o la bomba. Si los datos proceden
de una bomba o Guardian,  esta columna refleja los
valores de GS por punción digital  y los valores de GS
recibidos del medidor Link.

Linked BG Meter ID (ID del medidor de glucemia
vinculado)

Número de serie del medidor que envió una
determinada lectura de glucosa en sangre al
dispositivo.

Basal  Rate (U/h) (índice basal [U/h]) Índice basal activo de administración de insulina en
unidades por hora.

Temp Basal Amount (cantidad de basal temporal)
Si se aplicó un basal  temporal en la bomba, este
valor es el Temp Basal amount (Cantidad de basal
temporal).

Temp Basal Type (tipo de basal  temporal) El tipo de ajuste de los basales temporales (índice de
insulina o porcentaje del basal).
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Encabezado de la columna Definición

Temp Basal Duration (m) (duración del basal temporal
[min])

Duración, en minutos, de la administración de un
basal temporal de insulina (consulte el tipo más
arriba).

Bolus Type (tipo de bolus)
Tipo de bolus de insulina administrado (normal,
cuadrado, dual [parte normal] o dual [parte
cuadrada]).

Bolus Volume Selected (U) (volumen del bolus
seleccionado [U])

Número de unidades de insulina seleccionado para
administrarse durante el bolus de insulina.

Bolus Volume Delivered (U) (volumen del bolus
administrado [U])

Número de unidades de insulina administradas
realmente durante el  bolus de insulina.

Programmed Bolus Duration (h) (duración del bolus
programado [h])

Duración de un bolus cuadrado o de la parte
cuadrada de un bolus dual.

Prime Type (tipo de cebado)

Manual o fijo. El  cebado manual se utiliza justo
después de un rebobinado para llenar de insulina el
tubo del equipo de infusión antes de insertarlo. El
cebado fijo se utiliza después de la inserción del
equipo de infusión para llenar la cánula blanda con
insulina después de retirar la aguja introductora.

Prime Volume Delivered (U) (volumen de cebado
administrado [U])

Número de unidades de insulina administradas
realmente para el cebado.

Alarm (alarma) Nombre de la alarma generada.

Suspend (Suspender) Identifica el  estado suspendido de la bomba.

Rewind (rebobinar) La fecha y la hora en que el dispositivo fue
rebobinado.

BWZ Estimate (U) (estimación con Bolus Wizard [U]) Estimación del bolus de insulina calculado con la
función Bolus Wizard en la bomba Paradigm.

BWZ Target High BG (mg/dL or mmol/L) (límite
superior del objetivo de GS con Bolus Wizard [mg/dL o
mmol/L])

Valor para el límite superior del intervalo del objetivo
de glucosa en sangre utilizado por la función Bolus
Wizard.

BWZ Target Low BG (mg/dL or mmol/L) (límite inferior
del objetivo de GS con Bolus Wizard [mg/dL o
mmol/L])

Valor para el límite inferior del intervalo del objetivo
de glucosa en sangre utilizado por la función Bolus
Wizard.

BWZ Carb Ratio (ratio de carbohidratos con Bolus
Wizard)

Valor para la relación insulina/carbohidratos. Si  se
utilizan los gramos como unidad, el ratio es el
número de gramos cubiertos por una unidad de
insulina. Si se utilizan las raciones para las unidades,
el ratio es el número de unidades de insulina
utilizadas para cubrir una ración.

BWZ Insulin Sensitivity (sensibilidad a la insulina con
Bolus Wizard)

El valor para la sensibilidad a la insulina. La
sensibilidad a la insulina es la cantidad en que
disminuye el nivel  de glucosa en sangre por unidad
de insulina. Es utilizado por la función Bolus Wizard.

BWZ Carb Input (entrada de carbohidratos en Bolus
Wizard)

Cantidad de carbohidratos introducida en el Bolus
Wizard y utilizada para estimar un bolus.

BWZ BG Input (mg/dL or mmol/L) (entrada de GS en
Bolus Wizard [mg/dL o mmol/L])

Lectura de la glucosa en sangre introducida en el
Bolus Wizard y utilizada para estimar un bolus.

BWZ Correction Estimate (U) (estimación para
corrección con Bolus Wizard [U])

Unidades del bolus de insulina que hay que
administrar para corregir el nivel de glucosa en
sangre, calculadas por medio del Bolus Wizard.

BWZ Food Estimate (U) (estimación para la comida con
Bolus Wizard [U])

Unidades estimadas del bolus de insulina que hay
que administrar para cubrir la cantidad prevista de
ingesta de carbohidratos, calculadas por medio de la
función Bolus Wizard.
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Encabezado de la columna Definición

BWZ Active Insulin (U) (insulina activa con Bolus
Wizard [U])

Cantidad de insulina activa que se calcula que
quedará en el cuerpo de administraciones previas de
bolus de insulina al determinar la cantidad de bolus
estimada con la función Bolus Wizard.

Sensor Calibration BG (mg/dL or mmol/L) (GS para
calibración del sensor [mg/dL o mmol/L])

Valor de GS utilizado para calibrar el sensor, en
mg/dL o mmol/L.

Sensor Glucose (mg/dL or mmol/L) (glucosa del sensor
[mg/dL o mmol/L]) Valor de glucosa del sensor.

ISIG value (valor ISIG) Señales de entrada (ISIG), leídas por el sensor,
medidas en nanoamperios (nA).

Más información sobre los archivos CSV exportados por CareLink
Pro

El título mostrado en la parte superior del archivo CSV incluye la siguiente información:

• nombre del paciente

• lista de dispositivos seleccionados y sus números de serie

• intervalo de fechas seleccionado

Cada bloque de columnas tiene un título que incluye la siguiente información:

• nombre del dispositivo al que corresponde el bloque de datos

• número de serie de ese dispositivo

Si los datos no aparecen tal como se prevé

Existen diferentes factores que pueden provocar que los datos del archivo CSV se presenten

de manera distinta a la esperada.

• Los cambios en la fecha o la hora del dispositivo pueden modificar la secuencia o hacer que

los registros queden fuera del intervalo de fechas seleccionado para mostrar.

• Si existe un vacío grande entre las lecturas del dispositivo, es posible que los datos de dicho

dispositivo se presenten en varios bloques.
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Glosario

A1C -  Hemoglobina glucosilada.

Advertencia de reservorio bajo - Aviso programable que le informa con una alerta cuando queda
un número especificado de unidades en el reservorio o cuando resta una cantidad de tiempo
específica para que el reservorio quede vacío.

Área bajo la curva (AUC) - Indica la cantidad de las desviaciones superiores e inferiores según valores
predefinidos. Los datos de desviaciones indican la frecuencia de valores altos y bajos. El AUC indica
la magnitud de los eventos al mostrar el grado y la duración de la desviación.

Aviso de calibración - La bomba emitirá una alarma "Medir GS a HH:MM" automáticamente cada 12
horas, indicando que el valor de calibración actual ya no es válido. El valor del aviso de calibración
es el tiempo de antelación antes de que el valor de calibración actual caduque con que el usuario
desea que se le recuerde la calibración. Por ejemplo, si la opción de aviso de calibración está
configurada en 2 horas, la alarma "Medir GS a HH:MM" se activará 2 horas antes de que se necesite
la calibración.

Basal temporal (basal temp) - Insulina basal temporal única con una cantidad y una duración
específicas. Se utiliza para apoyar las necesidades de insulina durante actividades o situaciones
especiales que no forman parte de la rutina diaria normal.

Bolus corrector - Cantidad de insulina necesaria para devolver un nivel alto de glucosa en sangre a
un valor dentro del intervalo del objetivo de glucosa en sangre.

Bolus de comida - Dosis de insulina administrada para cubrir la elevación esperada de la glucosa en
sangre que se produce después de una comida.

Bolus de insulina - Dosis de insulina administrada para cubrir una elevación esperada de la glucosa
en sangre (como la elevación que tiene lugar después de una comida o un tentempié) o para
reducir un nivel alto de glucosa en sangre hasta el intervalo del objetivo de glucosa en sangre.

Bolus Dual Wave® (bolus dual) - Combinación de un bolus normal que se administra
inmediatamente, seguido de un bolus de onda cuadrada. La parte de onda cuadrada se administra
de manera uniforme durante cierto período de tiempo.

Bolus Express - Método de administración de cualquier tipo de bolus mediante el botón Bolus
Express de la bomba.

Bolus manual - Elemento opcional disponible en el BOLUS MENU (Menú Bolus) cuando la función
Bolus Wizard está activado. Método de programación de un bolus sin la función Bolus Wizard.

Bolus máximo - Cantidad máxima de bolus de insulina que la bomba administrará de una sola vez.
(Definido por el usuario).

Bolus normal - Administración inmediata de una cantidad de unidades de insulina específica.

Bolus Square Wave® (bolus cuadrado) - Bolus administrado de manera uniforme durante un
período de tiempo especificado (entre 30 minutos y 8 horas).
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CareLink® Personal - Servicio en línea que permite administrar los datos de diabetes a través de
Internet.

CH - Carbohidratos.

ComLink - Dispositivo transceptor de radiofrecuencia (RF) que se utiliza para descargar los datos de
las bombas Paradigm en el ordenador.

Com-Station - Dispositivo que se utiliza para descargar los datos de la bomba MiniMed 508 y de
medidores de otros fabricantes en el ordenador.

Concentración de insulina - Concentración o tipo de insulina que el médico ha recetado al usuario.
Afecta a la velocidad con la que la bomba administra la insulina. Si cambia la concentración de
insulina del usuario, deben volver a programarse los patrones basales y los índices basal máximo
y de bolus.

Easy Bolus™ - Método de infusión para un bolus normal utilizando el botón Easy Bolus de la bomba.

Equipo de infusión - Aparato utilizado para insertar y fijar una cánula bajo la piel y transportar la
insulina hasta el punto de inserción a través de un tubo desde la bomba.

Factor de bolus corrector - Cuánto rebajarán 1,0 unidades de insulina el nivel de glucosa en sangre.
Este factor se utiliza para calcular la cantidad del bolus corrector cuando la glucosa en sangre está
alta. (Nivel GS) - (Objetivo GS) = X. X ÷ (factor del bolus corrector) = cantidad del bolus corrector

Función Patrones - Función ampliada de la bomba que le permite programar basales opcionales
(Patrón A, Patrón B) que apoyan actividades que no forman parte de su rutina diaria pero que son
habituales en su estilo de vida. Tales actividades podrían ser la práctica de un deporte una vez por
semana, un cambio en sus hábitos de sueño durante el fin de semana o cambios hormonales
durante el ciclo menstrual.

Glucosa alta - La bomba generará una alarma si el sensor indica que el valor de glucosa del sensor
es igual o superior a este valor. Tiene la opción de activar o desactivar esta función.

Glucosa baja - La bomba generará una alarma si el sensor indica que el valor de glucosa del sensor
es igual o inferior a este valor. Tiene la opción de activar o desactivar esta función.

GS - Abreviación de glucosa en sangre

HbA1c - Hemoglobina glucosilada.

Hiperglucemia - Elevación de la glucosa en sangre detectada al controlar los niveles de glucosa en
sangre, con o sin alguno de los siguientes síntomas o todos ellos: náuseas, vómitos, visión borrosa,
cefalea, molestias gástricas, micción frecuente de grandes cantidades de orina y letargo.

Hipoglucemia - Disminución de la glucosa en sangre detectada al controlar los niveles de glucosa
en sangre, con o sin alguno de los siguientes síntomas o todos ellos: hambre excesiva, agitación
o temblores, sudoración, visión borrosa, mareo, cefalea, lenguaje farfullante, cambios súbitos del
estado de ánimo o cambios de la personalidad.

ID transm - Número de serie del transmisor que se está utilizando actualmente.

Incremento de insulina - Medición de insulina que puede ajustar y utilizar para la administración
de un Easy Bolus.

Índice basal - Ajuste de la bomba que proporciona una infusión continua de insulina para mantener
el nivel de glucosa en sangre estable entre las comidas y durante la noche. La insulina basal
reproduce la liberación de insulina pancreática, que cubre todas las necesidades de insulina no
relacionadas con las comidas.

Insulina basal - Infusión continua por horas de insulina administrada automáticamente por una
bomba de insulina según perfiles preprogramados e índices personalizados definidos en la
bomba. La bomba administra una infusión diaria de insulina que generalmente cubre las
necesidades "basales" de insulina durante los períodos de ayuno (por ejemplo, por la noche y
entre comidas).

Insulina basal máxima - Cantidad máxima de insulina basal que la bomba administrará de una sola
vez. (Definido por el usuario).

ISIG - Valores del sensor que indican si los componentes electrónicos del transmisor de un sistema
realzado con un sensor funcionan correctamente. Si el valor del parámetro ISIG es inferior a 24,00
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nA o superior a 29,00 nA, solicite asistencia técnica sobre el producto. Es posible que sea necesario
sustituir el transmisor.

Medidor - Dispositivo médico para determinar la concentración aproximada de glucosa en la sangre.
Se coloca una pequeña gota de sangre en una tira de análisis desechable, que el medidor lee y
utiliza para calcular el nivel de glucosa en sangre. A continuación, el medidor muestra el nivel en
mg/dL o mmol/L.

Opción del medidor - Función que permite que la bomba reciba lecturas de glucosa procedentes
de un medidor de glucemia vinculado.

Parte cuadrada - (Cuad) La segunda parte de un bolus dual. La parte cuadrada se administra de
manera uniforme durante un período de tiempo después de la parte AHORA.

Patrón estándar - El patrón basal normal que soporta su actividad diaria normal. Cuando la función
Patrones está desactivada, la bomba utiliza su patrón estándar (basal).

Patrones basales - El usuario puede programar un máximo de tres patrones de índice basal diferentes
en la bomba para la administración de insulina basal: Estándar, Patrón A y Patrón B. Para cada
patrón existe la opción de configurar un máximo de 48 índices basales.

Perfil basal - Índice basal con una hora inicial y final. El usuario puede programar varios perfiles
diferentes en la bomba, cada uno con un índice basal diferente, durante un período de 24 horas
para conseguir un mejor control de la glucosa.

Porcentaje de diferencia absoluta media (%DAM) - Representa el nivel de precisión de la
calibración del sensor con respecto a las lecturas del medidor de glucosa en sangre. Cuanto menor
sea este número, mayor será la precisión de la calibración. El %DAM se calcula tomando la
diferencia entre pares próximos de lecturas de glucosa del sensor y del medidor de glucosa en
sangre, dividiéndola por la lectura del medidor de glucosa en sangre y después calculando el
promedio de todos los pares.

Prueba de A1C - Prueba de hemoglobina A1C que se utiliza para interpretar el nivel de glucosa en
sangre durante un período de tiempo.

Prueba de cuerpos cetónicos - Los cuerpos cetónicos son productos de desecho que se generan
cuando el organismo se ve obligado a quemar grasas corporales en lugar de glucosa para obtener
energía. Puede ser un signo de falta de insulina en el organismo. La prueba de cuerpos cetónicos
mide la cantidad de cuerpos cetónicos concentrados en la sangre o la orina.

Prueba de HbA1c - Prueba de hemoglobina A1C que se utiliza para interpretar el control de la glucosa
en sangre o la media de los niveles durante un período de tiempo de 2 a 3 meses.

Ratio de CH (ratio de carbohidratos) - La cantidad de carbohidratos cubiertos por una unidad de
insulina. (Véase también Ratio de raciones).

Ratio de raciones - Cantidad de insulina necesaria para cubrir una (1) ración de carbohidratos. (Véase
también Ratio de CH).

RF - Radiofrecuencia (RF).

Sensibilidad a la insulina - Cantidad de mg/dL (o mmol/L) en que se reduce el nivel de glucosa en
sangre (GS) por unidad de insulina. (Datos de la función Bolus Wizard).

Sonido de bolus - La bomba puede programarse para que el usuario oiga un pitido cuando
seleccione una cantidad de bolus de insulina (0,5 ó 1,0 unidades) para administrar. Es útil para
situaciones en las que resulte difícil ver los botones de la bomba.

Suspender - Función de la bomba que detiene todas las administraciones de insulina. Se cancela
toda administración de bolus y/o cebado en curso. La administración basal queda en pausa hasta
su reanudación.

Temp - Temporal.

Transferencia - Proceso de envío de datos de la bomba o medidor al programa CareLink® Personal.

Unidades de carbohidratos - La entrada de una comida cuando se utiliza la función Bolus Wizard.
Se introduce en gramos (de carbohidratos) o raciones.

Vincular
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(1) Activar y configurar la opción del medidor que permite que la bomba reciba lecturas de GS
desde un medidor que se comunica con la bomba.
(2) También se utiliza en este programa para hacer referencia a los vínculos de hipertexto. Cuando
se hace clic en ellos, los vínculos de hipertexto llevan a otro lugar del programa o a otro sitio web.
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